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 • No part of this manual may be reproduced in any form. 
 • All specifications and designs are subject to change without notice. 
 
The products in this manual are controlled based on Japan’s “Foreign Exchange and 
Foreign Trade Law”. The export from Japan may be subject to an export license by the 
government of Japan. 
Further, re-export to another country may be subject to the license of the government of 
the country from where the product is re-exported. Furthermore, the product may also be 
controlled by re-export regulations of the United States government. 
Should you wish to export or re-export these products, please contact FANUC for advice. 
 
In this manual we have tried as much as possible to describe all the various matters. 
However, we cannot describe all the matters which must not be done, or which cannot be 
done, because there are so many possibilities. 
Therefore, matters which are not especially described as possible in this manual should be 
regarded as ”impossible”. 
 
This manual contains the program names or device names of other companies, some of 
which are registered trademarks of respective owners. However, these names are not 
followed by ® or ™ in the main body. 
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SAFETY PRECAUTIONS 
This manual includes safety precautions for protecting the user and preventing damage to the machine. 
Precautions are classified into Warnings and Cautions according to their bearing on safety. Also, 
supplementary information is described as Notes. Read the Warnings, Cautions, and Notes thoroughly 
before attempting to use the machine. 
 

 WARNING 
 Applied when there is a danger of the user being injured or when there is a 

damage of both the user being injured and the equipment being damaged if the 
approved procedure is not observed. 

 
 CAUTION 

 Applied when there is a danger of the equipment being damaged, if the 
approved procedure is not observed. 

 
NOTE 
 The Note is used to indicate supplementary information other than Warning and 

Caution. 
 
• Read this manual carefully, and store it in a safe place. 
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GENERAL WARNINGS AND CAUTIONS 
The following warnings and cautions describe the safety precautions related to the use of CNC units. It is 
essential that these precautions be observed by users to ensure the safe operation of machines equipped 
with a CNC unit.  
 

 WARNING 
1 Before operating the machine, thoroughly check the entered data. Operating the 

machine with incorrectly specified data may result in the machine behaving 
unexpectedly, possibly causing damage to the workpiece and/or machine itself, 
or injury to the user. 

2 Never attempt to machine a workpiece without first checking the programmed 
value, compensation value, current position, and external signal settings. Also, 
never attempt to machine a workpiece without first checking the operation of the 
machine. Before starting a production run, ensure that the machine is operating 
correctly by performing a trial run using, for example, the single block, feedrate 
override, or machine lock function, or by operating the machine with neither a 
tool nor workpiece mounted. Failure to confirm the correct operation of the 
machine may result in the machine behaving unexpectedly, possibly causing 
damage to the workpiece and/or machine itself, or injury to the user. 

3 Ensure that the specified feedrate is appropriate for the intended operation. 
Generally, for each machine, there is a maximum allowable feedrate. The 
appropriate feedrate varies with the intended operation. Refer to the manual 
provided with the machine to determine the maximum allowable feedrate. If a 
machine is run at other than the correct speed, it may behave unexpectedly, 
possibly causing damage to the workpiece and/or machine itself, or injury to the 
user. 

4 When using a tool compensation function, thoroughly check the direction and 
amount of compensation. 

 Operating the machine with incorrectly specified data may result in the machine 
behaving unexpectedly, possibly causing damage to the workpiece and/or 
machine itself, or injury to the user. 

5 The parameters for the CNC and PMC are factory-set. Usually, there is no need 
to change them. When, however, there is no alternative other than to change a 
parameter, ensure that you fully Failure to set a parameter correctly may result 
in the machine behaving unexpectedly, possibly causing damage to the 
workpiece and/or machine itself, or injury to the user. 

 
 CAUTION 

1 The operator's manual on the CNC screen display function does not cover the 
functions and operation of CNCs. For details of the functions and operation of a 
CNC, refer to the operator's manual for the CNC. 

2 Some machine operations and screen functions are implemented by the 
machine tool builder. For an explanation of their usage and related notes, refer 
to the manual provided by the machine tool builder. 

3 The CNC screen display function is designed to allow standard CNC screens to 
be displayed on the monitor of a personal computer. With this function, the same 
operation as the standard CNC operation can be performed. However, there are 
some operations that cannot be performed with this function. For details, see the 
notes and limitations described in this manual. 
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NOTE 
 Command programs, parameters, and variables are stored in nonvolatile 

memory in the CNC. Generally, the contents of memory are not lost by a power 
on/off operation. However, the contents of memory may be erased by mistake, 
or important data in nonvolatile memory may have to be erased because of 
recovery from a failure. 

 To enable the restoration of data as soon as possible if such a situation arises, 
always make a backup of the data. 

 
 

WARNINGS AND CAUTIONS RELATING TO THE CNC SCREEN 
DISPLAY FUNCTION 

Warnings and cautions relating to the CNC screen display function are explained in this manual. Before 
using the function, read this manual thoroughly to become familiar with the provided Warnings, Cautions, 
and Notes. 
The following section, “Other Cautions That Must Be Read,” provides points that are not explained in 
this manual, but must be noted when you use the CNC screen display function. Be sure to read the section 
before using the CNC screen display function. 
 
 

OTHER CAUTIONS THAT MUST BE READ 
This section provides points to be noted when you use the CNC screen display function. Be sure to read 
the following before using the CNC screen display function. 
 

 CAUTION 
1 This manual does not explain in detail those operations and parameters that vary 

from one CNC model to another and which vary with options. For an explanation 
of such operations and parameters, refer to the relevant CNC manual and the 
manual supplied by the machine tool builder. 

2 This manual describes as many reasonable variations in usage as possible. It 
cannot address every combination of features, options, and commands that 
should not be attempted. If a particular combination of operations is not 
described, it should not be attempted. 
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PREFACE 
Thank you for purchasing the CNC screen display function. 
 
CNC screen display function is software that allows performing display and operation similar to a CNC 
on the following Windows or the personal computer function with WindowsCE. 

- Microsoft® Windows® 95 
- Microsoft® Windows® 98 
- Microsoft® Windows NT® 4.0（Service Pack4 or later） 
- Microsoft® Windows® 2000 Professional 
- Microsoft® Windows® XP Professional 
- Microsoft® Windows® Vista Business 
- Microsoft® Windows® 7 Professional 
- Microsoft® Windows® 8 Pro 

 
The CNC screen display function of the Windows version is used on the following connection types. 

- Personal computer connected to High speed serial bus(HSSB) with CNC (HSSB connection) 
- Series 160i/180i/210i-A with PC function (HSSB connection) 
- Personal computer connected to Ethernet with CNC (Ethernet connection) 

 
The CNC screen display function of the Windows version targets the following CNC. In this manual, 
CNC type might be shown by abbreviation in parentheses. 

HSSB connection: 
- Series 16i/18i/21i/160i/180i/210i-A/B (Series 16i/18i/21i) 
- Series 30i/31i/32i-A/B, Series 35i-B (Series 30i/31i/32i/35i) 
- Power Motion i-A   (Power Motion i) 
- Power Mate i-D/H   (Power Mate i) 
- Series 0i-B   (Series 0i-B) 
- Series 0i-D   (Series 0i-D) 
- Series 0i-F   (Series 0i-F) 
- Series 15i/150i-A/B  (Series 15i) 
- Series 15/150-B   (Series 15-B) 

Ethernet connection: 
- Series 16i/18i/21i/160i/180i/210i-A/B (Series 16i/18i/21i) 
- Series 30i/31i/32i-A/B, Series 35i-B (Series 30i/31i/32i/35i) 
- Power Motion i-A   (Power Motion i) 
- Power Mate i-D/H   (Power Mate i) 
- Series 0i-B/C   (Series 0i-B/C) 
- Series 0i-D   (Series 0i-D) 
- Series 0i-F   (Series 0i-F) 
- Series 15i/150i-A/B  (Series 15i) 

 
The CNC screen display function for the personal computer function with WindowsCE operates on the 
following targets. In this manual, CNC type might show by abbreviation in parentheses. 

- Series 160is/180is/210is-A/B  (Series 160is/180is/210is) 
- Series 30i/31i/32i-A/B with the personal computer function with WindowsCE 

 (Series 30i/31i/32i with the personal computer function with WindowsCE) 
 
Read this manual thoroughly to ensure the correct use of the CNC screen display function. 
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NOTE 
1 The manual does not describe Windows basic operations. 
 When the user is not familiar with Windows, read the Windows manual first to 

learn Windows basic operations. 
2 The personal computer includes FANUC PANEL i. 

 
 CAUTION 

 FANUC holds the copyrights on this software product and associated manuals 
and other documents. Only one backup copy of this software product is 
permitted. Reproduction for other purposes is not allowed. This software can be 
installed on one computer only. 

 
The CNC screen display function uses the following product for which copyright is held by Microsoft 
Corporation: 
  • Microsoft® Windows® Visual C++TM 
 

 Microsoft, Windows, Windows NT and Vista are registered trademarks of Microsoft Corporation. 
 Visual C++ and .NET are registered trademarks of Microsoft Corporation. 
 
 

FEATURES AND LIMITATIONS OF THE CNC SCREEN DISPLAY 
FUNCTION 

The CNC screen display function has the following features: 
 

Features 
• This function enables the same display and operation as for the CNC to be performed on Windows, 

providing a more user-friendly environment. 
• This function enables user-created screens (screens created using C Executor, Macro Executor, PMC 

C) to be displayed. 
 
Note the following limitations: 
 

Limitations 
(1) Display 

• Use the personal computer in more than 256-color(For Windows XP Professional, Vista 
Business, 7 Professional or 8 Pro : 65,000 colors or more) display mode. 

• The CNC screen display function supports five types of resolutions, 640 × 480 dots (VGA), 
800 × 600 dots (SVGA), 1,024 × 768 dots (XGA), 1,280 × 960 dots (SXGA), and 1,280 × 768 
dots (WXGA). Available resolutions vary with models and settings. 

 Display cannot be achieved in a resolution greater than the monitor’s resolution. 
• When the CNC side has a CNC-dedicated display that is not part of a personal computer system, 

the LCD and MDI keyboard on the CNC side are unavailable during the execution of the CNC 
screen display function unless the dual display function is provided. 

• When the CNC is in graphic display mode (for example, a tool path is being drawn), executing 
the CNC screen display function does not produce a graphic display which is already drawn. 
Also when the CNC screen display function is terminated while graphic display is being 
performed on the CNC screen display function side, no graphic display is produced on the 
CNC side. Graphic display must be performed again on each side respectively. 

• The boot screen cannot be displayed. 
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• When characters and graphics are overlaid on one another, composite colors cannot be 
displayed. One of the colors, that of the characters or that of the graphic, must be specified as 
the priority color. (The default color is that of the characters.) 

• Color palette numbers 0 to 15 and 240 to 255 are unavailable because they are reserved by 
Windows. Therefore, when a screen created in 256-color mode is displayed with the CNC 
screen display function, the colors corresponding to these color palette numbers are not 
displayed correctly. 

• Screen programs created with the C Executor must be recompiled by using a library supporting 
the CNC screen display function supplied by FANUC. (Series 0i-B/C or Series 150-B is not 
supported C language Executor function.) 

• Animated simulation for the Super CAP T/Super CAPi T, CAPI, CAPII/Symbol CAPi T, 
Series 150-MFB/TFB, or a lathe system is not displayed properly. 

• The Manual Guide T screen cannot be displayed. 
• The CNC screen display function supports messages in English, Japanese, German, French, 

Italian, Spanish, and Portuguese. However, a Windows version of the desired language must be 
provided to display messages properly. 

 (The CNC screen display is set according to the CNC display language.) 
• When the CNC in the Series 160is/180is/210is or Series 30i/31i/32i with the personal computer 

function with WindowsCE is used, the display position cannot be moved. 
• The 9-inch view is not supported in a CNC in the Series 15-B and Series 15i. 
• When you use the secondary display unit for Ethernet connection or the shared display unit for 

Ethernet connection, the CNC screen display function cannot be used. 
• The 8.4-inch view is not supported in a CNC in the Series 0i-D. 
 
 

(2) Operation 
• The CNC screen display function supports only data input/output as a memory card utility. The 

type of data that can be input and output is the same as that of data the CNC can input to and 
output from a memory card. The functions below cannot be used. 

 ⋅ Editing PMC ladder programs directly from a memory card (ladder edit card function) 
 ⋅ Performing DNC operation, schedule operation and external subprogram call(M198) from 

a memory card (The performance is not enough.) 
 ⋅ Directly editing and running programs in a memory card (function for Series 

30i/31i/32i/35i, Series 0i-D/F, Power Motion i) 
 ⋅ Using Servo Guide by inserting a memory card into the slot 
 When the CNC side has a CNC-dedicated display that is not part of a personal computer system, 

or the CNC is of the stand-alone type, however, the ladder edit card function and Servo Guide 
function are enabled by inserting a memory card into the card slot of the CNC. 

• When the personal computer is connected to a CNC in the Series 16i/18i/21i, and a disk drive 
of the personal computer is specified as the file input/output destination, specify C: as a drive 
letter if file operation libraries below are used with the C Executor. 

  aux_file_mount Register a memory card 
  aux_file_unmount Cancel registration of a memory card 
  aux_file_memcinfo Obtain memory card status 
 When the personal computer is connected to a CNC in the Series 30i/31i/32i/35i, Series 

0i-B/C/D/F, Power Mate i, Power Motion i, or Series 150i, data of applications created with the 
C Executor cannot be input or output. When the CNC side has a CNC-dedicated display or the 
CNC is of the stand-alone type, however, data can be input and output if the card slot of the 
CNC is specified as the file input/output destination. 

• The CNC screen display function for the Series 30i/31i/32i with the personal computer function 
with WindowsCE does not contain the memory card utility function. The memory card utility 
function is factory-installed in Windows CE.NET OS and FANUC Standard 
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Applications/Libraries. With the memory card utility function, it is possible to input and output 
data, directly edit and run programs, and execute the Servo Guide function. 

 However, the CNC screen display function enables file input/output destination folders to be 
switched. 

• Position compensation and cursor control on the touch panel or by the mouse cannot be 
performed. For an Ethernet connection, dragging by the mouse cannot be performed. 

• Screen erasure is disabled. Use a function such as a screen saver function of the personal 
computer. 

• When the CNC screen display function is terminated forcibly by using, for example, 
[Ctrl]+[Alt]+[Delete], the CNC cannot display the screen for about 30 seconds after termination. 
After forcibly terminating the CNC screen display function, wait at least 30 seconds until the 
CNC can display the screen, then restart the CNC screen display function. (Any attempt to 
restart the CNC screen display function immediately after its termination will result in no 
response.) 

 In some cases with the Ethernet version, however, the CNC cannot display the screen for about 
three minutes after forcible termination. In such cases, wait at least three minutes until the CNC 
can display the screen, then restart the CNC screen display function. 

• Only one CNC screen display function can be started per CNC. 
 When a computer is connected using high-speed serial buses or via an Ethernet to establish 

connections to two or more CNCs, each CNC may have one window open for the CNC screen 
display function at the same time. 

• Pressing the [shift] key solely cannot trigger the screen copy function. 
• To switch to the loader screen on the Series 16i/18i/21i, use the [shift]+[help] ([shift]+[ESC]) 

keys. 
 
 

CHECKING THE PRODUCT PACKAGE 
This product package software consists of the following: 
 
• System DVD-ROM (for HSSB, version 4.9 or later) (for Ethernet, version 4.7 or later) 
 CNC Screen Display Function in CNC Application Development Kit (A08B-9010-J555) 
• System CD-ROM (for HSSB, version 2.7 or later) 
 CNC Screen Display Function (A02B-0207-K775) 
• System CD-ROM (for Ethernet, version 2.0 or later) 
 CNC Screen Display Function (A02B-0207-K776) 
• System floppy disks (for HSSB, version 2.6 or earlier) 
 CNC Screen Display Function (A02B-0207-K770#JP07) 
• System floppy disks (for Ethernet, version 1.11 or earlier) 
 CNC Screen Display Function (A02B-0207-K772#ZZ07) 
 

NOTE 
 Place an order for the product on DVD-ROM when you are a first-time buyer. 
 The product is available only on CD-ROM and DVD-ROM for CNCs in the Series 

30i/31i/32i/35i, Power Motion i or later. 
 
• System CD-ROM (Series 30i/31i/32i-/B with the personal computer function with WindowsCE) 
 Windows Embedded CE6.0 SDK (A08B-9110-J708#ZZ11) 
• System CD-ROM (Series 30i/31i/32i-A with the personal computer function with WindowsCE) 

(Enhanced GUI Function hardware) 
 CNC Screen Display Function (A08B-9110-J803#ZZ11) 
• System CD-ROM (Series 30i/31i/32i-A with the personal computer function with WindowsCE) 

CNC Screen Display Function (A08B-9110-J801#ZZ11) 
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• System floppy disks (Series 160is/180is/210is-B) 
CNC Screen Display Function (A02B-0207-K774#ZZ07) 

• System floppy disks (Series 160is/180is/210is-A) 
CNC Screen Display Function (A02B-0207-K771#ZZ07) 

 
NOTE 
 Read the Release Note (README.TXT), provided on the second floppy disk of 

this product package. It provides detailed information on this product package 
and information not described in the operator's manual. 

 
 

ORGANIZATION OF THIS MANUAL 
This manual has the following organization: 
 
SAFETY PRECAUTIONS 
 Explains the general precautions which must be observed to ensure safety when using the CNC 

screen display function. 
PREFACE 
 Briefly explains the features of the CNC screen display function. Also explains how to use this 

manual and provides other information on the usage of the CNC screen display function. 
1. SETUP 
 Explains how to set up the environment for operating the CNC screen display function and to 

prepare the CNC screen display function for use. 
2. OPERATION 
 Explains how to use the CNC screen display function. 
3. SETTING 
 Explains how to switch from one language to another in the CNC screen display function, and how 

to change the keyboard assignment. 
APPENDIX A 
 Explains the alarms that are generated during the execution of the CNC screen display function and 

the actions to be taken. 
APPENDIX B 
 Explains the communication log function for Ethernet version of the CNC screen display function. 
APPENDIX C 
 Explains the bitmap server function in the CNC screen display function. 
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NOTATION CONVENTIONS 
The following explains the notation conventions used in this manual: 
 
• Menu, command, and screen notations 
 Example   Explanation                                                
 [File] menu Menu names are enclosed in brackets [ ]. 
 [Title bar]        Command names are enclosed in brackets [ ]. 
 <OK> button Command buttons on the display are enclosed in angle brackets < >. 
 
• Key notations and operation  
 Example   Explanation                                                
 [Enter] key Key names are enclosed in brackets [ ]. 
 [Ctrl]+[Tab] keys When keys are to be pressed and held down sequentially, the keys are indicated 

by connecting them with +, as shown to the left. 
 Direction keys The [→], [←], [↑], and [↓] keys are collectively called the direction keys. 
 
• Mouse/touch panel operation notations 
 Example   Explanation                                                
 Click   Press a mouse button, then release it immediately. 

 On a touch panel, use a stylus to touch the touch panel, and then release the 
stylus immediately. This is also called tapping. 

 Double-click Click a mouse button twice in quick succession. 
 On a touch panel, use a stylus to tap the touch panel twice in quick succession. 

This is also called double-tapping. 
 Drag    Move the mouse while holding down a mouse button, then release the button at 

a desired location. 
  On a touch panel, move a stylus while holding down it on the touch panel, and 

then release the stylus at a desired position. 
 
• Others 
 Example   Explanation                                                
 Display unit  This indicates the display unit for a CNC in the Series 160is/180is/210is or 
 (with WindowsCE)  Series 30i/31i/32i with the personal computer function with WindowsCE. 
 
• Sample screens 
 The screens shown in this manual are sample screens for a Series 16i CNC unless otherwise 

specified. 
 The screens shown in this manual are merely examples. Note that the screen layouts and displayed 

file names may vary depending on the equipment being used. 
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1 SETUP 
This chapter explains how to set up the environment for operating the CNC screen display function, and 
how to prepare the CNC screen display function for operation. 
 
Chapter 1, “SETUP”, consists of the following sections: 
 

1.1 SETUP (HSSB VERSION) 1 
1.2 SETUP (ETHERNET VERSION) 5 
1.3 SETUP (Personal computer function with WindowsCE VERSION) 9 

 

1.1 SETUP (HSSB VERSION) 
This section describes information related to the setup of the HSSB version of the CNC screen display 
function. 
 

 
 See Section 1.2, "Setup (Ethernet Version)," for explanations about the setup of the Ethernet version 

of the CNC screen display function. 
 

1.1.1 Operating Environment 
The software operating environment for the CNC screen display function is as follows: 
 
• Computer 

⋅ Series 160i/180i/210i with the personal computer function 
⋅ Personal computer attached to high-speed serial bus 

(connected to the Series 160i/180i/210i, Series 30i/31i/32i/35i, Power Motion i, Power Mate i, 
Series 0i-B/D,  
Series 150i or Series 150-B) 

• Operating system Windows 95 / 98 
Windows NT4.0 
⋅ Windows 2000 Professional 
⋅ Windows XP Professional 
⋅ Windows Vista Business 
⋅ Windows 7 Professional 
⋅ Windows 8 Pro 

• Display 
⋅ Resolution: 640 × 480 or higher resolution 
 For Windows XP Professional or Vista Business or 7 Professional or 8 Pro : 
 800 × 600 or higher resolution 
⋅ Color : 256 colors or more (16-color mode cannot be used) 
 For Windows XP Professional or Vista Business or 7 Professional or 8 Pro : 
 65,000 colors or more 

• Required hard disk space 
⋅ 20 MB or more 
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NOTE 
1 Maximum performance sometimes cannot be achieved depending on the 

type, performance, and usage of the personal computer. 
2 As with other Windows applications, this function is subject to restrictions 

when operating in multitasking mode. That is, the CNC screen display 
function affects the execution speed of other applications, and other 
applications affect the execution speed of the CNC screen display function. 

 

1.1.2 Installing the CNC Screen Display Function 
This subsection explains how to install the CNC screen display function. 
 

NOTE 
 Before the installation of the CNC screen display function, install and set the 

following necessary drivers according to the operating environment. 
 • HSSB device driver 
 • MDI keyboard driver (PANEL i and Series 160i/180i/210i with Personal 

 Computer  Function ) 
 For more information, see the Release Note (README.TXT/READMEJ.TXT) 

provided on the driver library CD-ROM (A02B-0207-K737), floppy disks 
(A02B-0207-K730#ZZ07), or PANEL i drivers disk CD-ROM (A08B-0084-K790). 

 In case of Windows XP Embedded, see the Release Note (README.TXT/ 
READMEJ.TXT) provided in the C:\DriversDisk folder. 

 
Procedure for installing the CNC screen display function 

1. Insert the system CD-ROM (A02B-0207-K775) or the system DVD-ROM (A08B-9010-J555) into 
the CD/DVD-ROM drive, or insert Disk1 of the system floppy disks (A02B-0207-K770#JP07) into 
the floppy disk drive. 

2. Select the [Start] menu. 
3. Select [Run...]. 
4. Enter <drive-name>:SETUP, and select the <OK> button. (<drive-name> is the name of the 

CD-ROM drive or floppy disk drive.) 
In case of the system DVD-ROM (A08B-9010-J555), enter the following character string, and select 
the <OK> button. 
 <DVD-ROM drive-name>:\CNC Screen Display Fuction\HSSB\Setup.exe 

 
NOTE 
 In case of Windows Vista/7/8, a User Account Control (UAC) dialog is displayed.  

Click the <Allow> button to perform installation. 
 
5. Install the CNC screen display function according to the displayed messages. 
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1.1.3 Repairing and Uninstalling the CNC Screen Display Function 
This subsection explains how to repair and uninstall the CNC screen display function. 
 

Procedure for repairing and uninstalling the CNC screen display function 
1. Choose the [Start] menu. 
2. Choose [Control Panel]. 
3. Execute [Add/Remove Programs]. 
 
 The Add/Remove Programs screen appears. 

  
4. Choose the CNC Screen Display Function. 
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5. Choose the <Change/Remove...> button. 
 
 The Maintenance Dialog screen appears. 

  
 The Maintenance Dialog screen allows you to perform the following: 
 
  “Modify” Install or uninstall components. 
  “Repair” Reinstall the CNC screen display function. 
  “Remove” Uninstall the CNC screen display function. 
 

 
 You need not select “Modify” because the CNC screen display function contains only one 

component. 
 
6. Select the desired action and choose the <Next> button. 
 
 When you select “Remove”, the uninstall function starts, prompting you to choose whether you want 

to uninstall the program. 

  
 To uninstall the program, choose the <OK> button. 
 
 When the CNC screen display function has been uninstalled normally, the function is deleted from 

the Windows program menu. 
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1.2 SETUP (ETHERNET VERSION) 
This section describes information related to the setup of the Ethernet version of the CNC screen display 
function. 
 

 
 See Section 1.1, "Setup (HSSB Version)," for explanations about the setup of the HSSB version of 

the CNC screen display function. 
 

1.2.1 Operating Environment 
The software operating environment for the CNC screen display function is as follows: 
 
• Operating system Windows 95 / 98 

 Windows NT4.0 
 Windows 2000 Professional 
 Windows XP Professional 
 Windows Vista Business 
 Windows 7 Professional 
 Windows 8 Pro 

• Display 
⋅ Resolution: 640 × 480 or higher resolution 
 For Windows XP Professional or Vista Business or 7 Professional/8 Pro : 
         800 × 600 or higher resolution 
⋅ Color : 256 colors or more (16-color mode cannot be used) 
 For Windows XP Professional or Vista Business or 7 Professional/8 Pro : 
         65,000 colors or more 

• Required hard disk space 
⋅ 20 MB or more 
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NOTE 
1 Maximum performance sometimes cannot be achieved depending on the type, 

performance, and usage of the personal computer. 
2 As with other Windows applications, this function is subject to restrictions when 

operating in multitasking mode. That is, the CNC screen display function affects 
the execution speed of other applications, and other applications affect the 
execution speed of the CNC screen display function. 

3 The Ethernet version of the CNC screen display function is implemented through 
socket communication (TCP/IP communication) with a FANUC Ethernet board or 
FANUC Fast Ethernet board. Before using the function, refer to the relevant 
manuals to check the following items. 
• TCP/IP setting in the personal computer 
• Setting of the FANUC Ethernet board and FOCAS1/2/ Ethernet function in 

the CNC 
• Network connection between the personal computer and CNC 
• For Series 16i/18i/21i/Power Mate i, Series 0i-B/C and Series 15i 
 FANUC Ethernet Board OPERATOR’S MANUAL (B-63354EN)」 
 FANUC Fast Ethernet Board / Fast Data Server OPERATOR’S MANUAL 

(B-63644EN)」 
• For Series 30i/31i/32i/35i, Series 0i-F and Power Motion i 
 FANUC Fast Ethernet / Fast Data Server OPERATOR’S MANUAL 

(B-64014EN) 
• For Series 0i-D 
 FANUC Fast Ethernet / Fast Data Server OPERATOR’S MANUAL 

(B-64414EN) 
4 In Embedded Ethernet for Series 16i/18i/21i-B, the CNC Screen Display 

Function is not supported. 
5 In Embedded Ethernet for Series 30i/31i/32i-A and Series 0i-D, only the CNC 

Screen Display Function by "the Ethernet display function of Stand-alone type 
CNC" is supported. 

 

1.2.2 Installing the CNC Screen Display Function 
This subsection explains how to install the CNC display function. 
 

Procedure for installing the CNC screen display function 
1. Insert the system CD-ROM (A02B-0207-K776) or the system DVD-ROM (A08B-9010-J555) into 

the CD/DVD-ROM drive, or insert Disk1 of the system floppy disks (A02B-0207-K772#ZZ07) into 
the floppy disk drive. 

2. Choose the [Start] menu. 
3. Choose [Run...]. 
4. Enter <drive-name>:SETUP, and choose the <OK> button. (<drive-name> is the name of the 

CD-ROM drive or floppy disk drive.) 
In case of the system DVD-ROM (A08B-9010-J555), enter the following character string, and select 
the <OK> button. 
 <DVD-ROM drive-name>:\CNC Screen Display Fuction\Ethernet\Setup.exe 
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NOTE 
 In case of Windows Vista/7/8, a User Account Control (UAC) dialog is displayed.  

Click the <Allow> button to perform installation. 
 
5. Install the CNC screen display function according to the display messages. 
 

1.2.3 Repairing and Uninstalling the CNC Screen Display Function 
This subsection explains how to repair and uninstall the CNC screen display function. 
 

Procedure for repairing and uninstalling the CNC screen display function 
1. Choose the [Start] menu. 
2. Choose [Control Panel]. 
3. Execute [Add/Remove Programs]. 
 
 The Add/Remove Programs Properties screen appears. 

  
4. Choose the CNC Screen Display Function (Ethernet). 
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5. Choose the <Add/Remove...> button. 
 
 The Maintenance Dialog screen appears. 

  
 The Maintenance Dialog screen allows you to perform the following: 
 
  “Modify” Install or uninstall components. 
  “Repair” Reinstall the CNC screen display function. 
  “Remove” Uninstall the CNC screen display function. 
 

 
 You need not select “Modify” because the CNC screen display function contains only one 

component. 
 
6. Select the desired action and choose the <Next> button. 
 
 When you select “Remove”, the uninstall function starts, prompting you to choose whether you want 

to uninstall the program. 

  
 To uninstall the program, choose the <OK> button. 
 
 When the CNC screen display function has been uninstalled normally, the function is deleted from 

the Windows program menu. 
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1.3 SETUP (Personal computer function with WindowsCE 
VERSION) 

This section provides information related to the setup of the CNC screen display function for CNCs in the 
personal computer function with WindowsCE version. 
 

1.3.1 Operating Environment 
This software is intended only for use with CNCs in the Series 160is/180is/210is or Series 30i/31i/32i 
with the personal computer function with WindowsCE. 
 

NOTE 
 Like other Windows applications, this function runs in multitasking mode and 

subject to operational constraints. This means that the CNC screen display 
function affects the execution speed of another application, which in turn affects 
the execution speed of the CNC screen display function. 

 

1.3.2 Installing the CNC Screen Display Function 
The CNC screen display function is preinstalled in the Series 160is/180is/210is or Series 30i/31i/32i with 
the personal computer function with WindowsCE. Normally, installation is not required. Use the 
following procedure to install the function for upgrading. 
 

Procedure for installing the CNC screen display function 
1. Copy the executable of the CNC screen display function to the root folder of the ATA card. 
 
 For Series 160is/180is/210is 

(a) Copy the compressed file of the CNC screen display function to an empty folder in a 
development personal computer. The file is a self-extracting compressed file. The name of the 
compressed file depends on your OS and CNC model as shown below. 

 • Series 160is/180is/210is-A (A02B-0207-K771#ZZ07) 
  Windows CE2.00: WINCE200.EXE 
  Windows CE2.12: WINCE212.EXE 
 • Series 160is/180is/210is-B (A02B-0207-K774#ZZ07) 
  CSDFWCE300.EXE 
(b) Run the copied file. The file uncompresses the compressed contents. 
(c) Copy the restored Setupis.exe file and CNCScrn folder to the root folder of the ATA card. 
 

 For Series 30i/31i/32i with the personal computer function with WindowsCE 
 Copy the contents (file and folder) of the CD-ROM to the root folder of the ATA card. 

 
2. Turn on the power to the CNC. 
3. Insert into the PCMCIA slot of the CNC the ATA card containing the copy of the file. 
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4. Open My Computer on the desktop. 

  
5. Ensure that the ATA card is automatically recognized as "Storage Card2" or "Storage Card3". 

  
6. Open the "Storage Card2" or "Storage Card3" and start Setupis.exe. 
 The setup screen appears. 

  
7. With the check box selected for the CNCScrn program to be installed, press the “OK” button or 

“INPUT” key. 
8. When the installation completes, the message below appears. Then, remove the ATA card, turn the 

power off and then back on. 

  
 

 
 When you insert the ATA card containing the copy of the program and turn on the power to the 

CNC, Setupis.exe starts automatically. 
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NOTE 
 Do not turn off the power to the CNC while Setupis.exe is running. If you turn off 

the power to the CNC during the copying, the data in the compact flash memory 
may be corrupted. 

 

1.3.3 Uninstalling the CNC Screen Display Function 
To uninstall the CNC screen display function, remove the following folder. 
 
 \Storage Card\FANUC\CNCScrn 
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2 OPERATION 
This chapter explains how to operate the CNC screen display function. 
Chapter 2, “OPERATION”, consists of the following sections: 
 

2.1 START AND TERMINATION (HSSB VERSION) 12 
2.2 START AND TERMINATION (ETHERNET VERSION) 20 
2.3 START AND TERMINATION (Personal computer function with WindowsCE VERSION) 
    28 
2.4 TYPES OF DISPLAYED SCREENS 30 
2.5 INPUT FROM THE KEYBOARD 34 
2.6 INPUT WITH THE MOUSE AND TOUCH PANEL 37 
2.7 FUNCTION KEYS 37 
2.8 DATA INPUT/OUTPUT 40 
2.9 CLEARING ALARMS 44 
2.10 COPYING SCREENS  45 
2.11 DISPLAYING VERSION INFORMATION 46 

 

2.1 START AND TERMINATION (HSSB VERSION) 
This section explains how to start and terminate the HSSB version of the CNC screen display function, 
and explains the points to be noted when the function is started. 
 

 
 See Section 2.2, "Start and Termination (Ethernet Version)," for explanations about how to start and 

terminate the Ethernet version of the CNC screen display function. 
 

2.1.1 Starting the CNC Screen Display Function 
The following explains the procedure for starting the CNC screen display function from the Windows 
start menu, and explains the points to be noted when you start the function. 
 

Procedure 
1. Choose the [Start] menu. 
2. Choose the [Programs] command. 
3. Choose the CNC Screen Display Function command. 
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 The following CNC Screen Display Function screen appears: 
 
 Example 1. 
  CNC screen display function on the Series 160i/180i/210i 

   
 Example 2. 
  CNC screen display function on the Series 30i/31i/32i/35i, Series 0i-D/F, Power Motion i 
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 In a CNC in the Series 160i/180i/210i or Series 0i-B, you can use the command line argument /M to 

specify a text file containing strings you want to display on the CNC screen during startup of the 
CNC screen display function. This allows you to display any message on the CNC screen. A 
message can be displayed in a field of 32 characters by 8 lines, and can contain up to 256 characters. 
The format of the command line specification is as follows. 

 
CNCSCRNE  /M=<file-name (full path)> 

 
 Characters that cannot be displayed on the CNC are replaced with spaces. 
 
4.  When the display has the same resolution as the CNC screen, clear [Title bar] in the submenu of 

[View] on the menu bar to hide the title bar, thereby maximizing the CNC screen on the display. 

   
 To hide the Windows taskbar, select [Display above task bar] in the submenu of [View] on the menu 

bar. 

  
5. To display the title bar, perform the following: 
 When using the mouse  : Click the right button. 
 When using the full keyboard  : [Shift]+[F10] 
 When using the MDI keyboard : [SHIFT]+[GRAPH] 
 
 A pop-up menu, shown below, appears. Choose [Title bar]. 
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NOTE 
1 When the CNC screen display function is started on the Series 160i/180i/210i 

or Series 0i-B, the CNC display screen to be displayed is determined according 
to the following CNC parameters: 

   CNC parameters: Nos. 3198 and 3199 
 (CNC parameter for enabling the above parameters: Bit 6 of parameter No. 

3103) 
 When the CNC screen display function is started for the Power Mate i, the 

position display screen appears. 
 When the CNC screen display function is started on the Series 30i/31i/32i/35i, 

Series 0i-D/F, Power Motion i, Series 150i or Series 150-B, the screen that was 
selected on the CNC before this function is started remains displayed. 
Likewise, when the CNC screen display function is ended, the screen that was 
displayed by this function is displayed on the CNC. Note that when the PMC 
screen is displayed, the screen of the CNC that was displayed before the PMC 
screen is displayed is displayed. Also, when the CNC screen display function is 
started or ended with the help menu or multi-teaching function pop-up menu 
displayed, these screens are cleared. 

2 When a resolution is larger than the CNC screen size, the title bar is always 
shown (the menu item [Title bar] is unavailable). 

3 To perform dual display, set the following parameter: 
 CNC parameter: Set bit 7 of parameter No. 3206 to 1. 
 The option for the dual display function must be provided for a CNC. 

 

2.1.2 Starting the CNC Screen Display Function (Multiple 
Connection) 

The CNC screen display function allows one personal computer to be used for operating up to eight 
CNCs (Series 16i/18i/21i, Series 0i-B/D/F, Series 30i/31i/32i/35i, Power Motion i, Power Mate i, Series 
15i or Series 15-B) when these CNCs are connected to the personal computer via high-speed serial bus. 
The response to manipulation for display becomes slower as the number of connected CNCs increases. 
 

 
CNC 

       No.n 

CNC 

       No.2

CNC 

       No.1 

High-speed 
serial bus 
board No. n

High-speed 
serial bus 
board No. 2

High-speed 
serial bus 
board No. 1

.........

Personal computer 

 
 

Starting the function 
When more than one CNC is connected or can be connected, the CNC screen display function can be 
executed more than once at the same time. In this case, each time the CNC screen display function is 
started, the following CNC select screen appears: 
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The buttons have the following meanings: 

  : Executes the CNC screen display function. When the CNC screen display function is 
already running, the running CNC screen display function is displayed on top. 

  : Stops the current CNC screen display function. 
  : Terminates the CNC screen display function. 

 
Explanation of the list 

The list contains the following information: 
 

- General format of the list 
 CNC No. = 01 160/180/210 Connecting 
 
       Connection status 
         Disconnect 
         Connecting 
         Executing 
      CNC model 
        160/180/210 (Series 160i/180i/210i) 
        0i -B (Series 0i-B) 
        160i/180i-W (Series 160i/180i-W) 
        Power Mate-i (Power Mate i) 
        150i (Series 150i) 
        150-B (Series 150-B) 
        Auto detection 
      CNC number (00 to 07) 

 
(1) CNC number 

 The number of a CNC that can be connected is indicated. 
(2) CNC model 
 The model of the CNC that is connected or which can be connected is indicated. 
(3) Connection status 

Disconnect : 
 The power to the CNC is off, or the cable is not connected correctly. 
 In this state, neither the  button nor  button can be chosen. 
Connecting : 
 The CNC is connected correctly. 
 Choosing the  button executes the CNC screen display function. 
 The  button cannot be chosen. 
Executing  : 
 The CNC screen display function is running. 
 Choosing the  button displays the currently executed CNC screen on top. 
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 Choosing the  button stops the CNC screen display function. When this 
button is chosen, the connection status in the list changes from Executing to Connecting. 

 
NOTE 
 When a CNC in the Disconnect status has been connected correctly, perform 

the following operation. Then, the status indication changes to Connecting, and 
the  button can be chosen. 
(1) With the mouse, click an arbitrary CNC in the list. 
(2) With the cursor keys, select another item in the list. 

 

 
 The CNC to be connected can be specified using an argument on the command line. When this 

argument is used, the above Select CNC screen does not appear. The format of the command 
line specification is as follows: 

 
CNCSCRN  /NODE = <CNC-number> 

 
  The /M and /NODE arguments can be specified at the same time. 
 

2.1.3 Terminating the CNC Screen Display Function 
The following explains how to terminate the CNC screen display function. 
As explained below, there are several termination methods. You can use any of these methods to 
terminate the CNC screen display function. 
 

Operation 1 
 Terminating from a pop-up menu 
 Click the right button of the mouse on the screen of the CNC screen display function. A pop-up 

menu as shown below appears. Choose [Exit]. 

  
Operation 2 

 Terminating from the menu bar 
 Choose [Exit] from the submenu of [File]. 
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Operation 3 
 Terminating from the title bar 
 Click . 

  
 

Operation 4 
 Terminating from the keyboard 

• On the PS/2 keyboard or USB full keyboard, press [Alt]+[F4]. 
• On the MDI keyboard: 

⋅ Series 160i/180i/210i 
 Press the unlabeled key (or [FAPT]) + [SHIFT] + [DELETE]. 
⋅ Series 30i/31i/32i/35i, Series 0i-D/F, Power Motion i 
 Press [ALT] + [SHIFT] + [DELETE]. 

 
 If the function is terminated due to a broken communication rather than by any of the above 

methods, the message below appears. 

  
 To suppress this message, clear [Display communication error] in the submenu of [View]. 

  
 

NOTE 
 During the termination processing for the CNC screen display function, the 

following message appears: 

  

 If the CNC screen display function is restarted while this message is being 
displayed, the CNC screen display function may operate abnormally. When 
restarting the CNC screen display function, restart the function after the above 
message disappears. 

 



B-63164EN/11  2.OPERATION 

- 19 - 

2.1.4 Termination by Means of the PMC Signal 
The following explains how to terminate the CNC screen display function by means of the PMC signal. 
 

 
 Not using this function does not influence the operation of the CNC screen display function. Use it 

as required. 
 
Turning on a specified machine signal terminates the CNC screen display function. To specify the 
machine signal, follow the procedure below. 
 

Procedure 
1. Choose the [Close Signal…] from the submenu of [Option] in the menu bar. 

  
2. The Close Signal dialog box appears. 

  
3. Enter the target PMC signal in the Signal text box, using the following format, then choose the 

 button. 
 
 <signal-address>.<bit-position>  Example)  X0004.7 
 

 
 The close signal can be specified also using an argument on the command line. 
 The format of the command line specification is as follows: 
 

CNCSCRNE  /S=<signal-address>.<bit-position> 
 
 The /M, /NODE and /S arguments can be specified simultaneously. 
 

NOTE 
 The setting of the machine signal is preserved. It is impossible to start the CNC 

screen display function if the set signal is kept turned on with the PMC sequence 
program. 
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2.2 START AND TERMINATION (ETHERNET VERSION) 
This section explains how to start and terminate the Ethernet version of the CNC screen display function, 
and explains the points to be noted when the function is started. 
 

 
 See Section 2.1, "Start and Termination (HSSB Version)," for explanations about how to start and 

terminate the HSSB version of the CNC screen display function. 
 

2.2.1 Start 
The following explains the procedure for starting the CNC screen display function from the Windows 
start menu, and explains the points to be noted when the function is started. 
 

Procedure 
1. Choose the [Start] menu. 
2. Choose the [Programs] command. 
3. Choose CNC Screen Display Function (Ethernet) to start it. 

  
 
4. When the CNC screen display function is started, the following screen appears to specify the 

destination: 

  
 When the function is started for the first time or the  is selected, the screen changes 

to the following: 
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 On this screen, enter the following items. 
 
 Host  : Specify a host name (such as "CNC1") or an IP address (such as "190.0.2.31"). 
 Port no. : Specify the port number for the FOCAS1/2/Ethernet function. 
 Timeout : Specify a timeout value for graphic data transmission/reception in seconds. 

 Entering 0 disables timeout processing, causing an infinite wait. 

 
 A host name and port number can be specified using arguments on the command line. When these 

arguments are used, the above screen to specify the destination does not appear. The format of the 
command line specification is as follows: 

 
CNCSCRNE /H=<host-name>:<port-number>  
 /T=<timeout-value (by default, 30)> 

 
 The /H and /T arguments can be specified at the same time. 
 

 
 You can also specify a host name or IP address, a port number and timeout value by using a text file 

(with the extension .FSDF) containing the settings of these items. The format of the FSDF file data 
is as follows: 

 
(Line 1) IP = <host-name>:<port-number> 
 <timeout-value (by default, 30)> 
(Line 2) Name = <destination-machine-name (currently unused)> 
 Example: 
  IP = 192.168.2.32:8193 30 
  Name = FANUC ROBODRILL α-T14iC 

 
 The CNC screen display function has been associated with the FSDF file during setup. You can start 

the CNC screen display function by double-clicking the FSDF file, or by right-clicking the FSDF 
file and then choosing [Open] from a menu that appears. 

 The format of the command line specification of the FSDF file is as follows: 
 

CNCSCRNE  <FSDF file-name (full path)> 
 
5. Choosing the  button causes the screen to change to the following: 
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NOTE 
 It may take several minutes for the Ethernet version to start. Choosing 

 discontinues the start sequence. 
 
 When the CNC is connected successfully, the CNC Screen Display Function screen appears. 
  
 Example 1 For Series 16i/18i/21i 

   
 Example 2 For Series 30i/31i/32i/35i, Series 0i-D/F, Power Motion i 

   

 
 In a CNC in the Series 16i/18i/21i or Series 0i-B/C, you can use the command line argument /M to 

specify a text file containing strings you want to display on the CNC screen during startup of the 
CNC screen display function. This allows you to display any message on the CNC screen. A 
message can be displayed in a field of 32 characters by 8 lines, and can contain up to 256 characters. 
The format of the command line specification is as follows. 
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CNCSCRNE  /M=<file-name (full path)> 
 
 The /M, /H, and /T arguments can be specified at the same time. Characters that cannot be displayed 

on the CNC are replaced with spaces. 
 
6. When the display has the same resolution as the CNC screen, clear [Title bar] in the submenu of 

[View] on the menu bar to hide the title bar, thereby maximizing the CNC screen on the display. 

  

 To hide the Windows taskbar, select [Display above task bar] in the submenu of [View] on the menu 
bar. 

  
7. To display the title bar, perform the following: 
 When using the mouse : Click the right button. 
 When using the keyboard : [Shift]+[F10] 
 
 A pop-up menu, shown below, appears. Choose [Title bar]. 
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NOTE 
1 When the CNC screen display function is started in the Series 16i/18i/21i or 

Series 0i-B/C, the CNC display screen to be displayed is determined according 
to the following CNC parameters: 

 CNC parameters: Nos. 3198 and 3199 
 (CNC parameter for enabling the above parameters: Bit 6 of parameter No. 

3103) 
 When the CNC screen display function is started for the Power Mate i, the 

position display screen appears. 
 When the CNC screen display function is started on the Series 30i/31i/32i/35i, 

Series 0i-D/F, Power Motion i or Series 15i, the screen that was selected on 
the CNC before this function is started remains displayed. Likewise, when the 
CNC screen display function is ended, the screen that was displayed by this 
function is displayed on the CNC. Note that when the PMC screen is displayed, 
the screen of the CNC that was displayed before the PMC screen is displayed 
is displayed. Also, when the CNC screen display function is started or ended 
with the help menu or multi-teaching function pop-up menu displayed, these 
screens are cleared. 

2 When a resolution is larger than the CNC screen size, the title bar is always 
shown (the menu item [Title bar] is unavailable). 

3 To perform dual display, set the following parameter: 
 CNC parameter: Set bit 7 of parameter No. 3206 to 1. 
 The option for the dual display function must be provided for a CNC. 

 

2.2.2 Start (Multiple Connection) 
The Ethernet version of the CNC screen display function allows one personal computer to be used for 
operating two or more CNCs connected over an Ethernet network (the maximum number of connectable 
CNCs is determined according to the related Ethernet limitation). The response to manipulation for 
display becomes slower as the number of connected CNCs increases. 
 

 CNC
     No.1

 CNC
     No.2

 CNC
     No.n----

Ethernet

Personal computer

 
 

Starting the function 
This function can be started using the same starting procedure described in Subsection 2.2.1. Specify the 
host name (such as "CNC1" or "CNC2") or IP address that matches the CNC to be connected. 
 

Simultaneous Ethernet and high-speed serial bus connection 
It is possible to run the CNC screen display function for a CNC connected via the high-speed serial bus 
and that for the CNC connected via the Ethernet simultaneously on a single personal computer. To set up 
the functions for this purpose, perform the setting procedures described in both Section 1.1, "Setup 
(HSSB Version)," and Section 1.2, "Setup (Ethernet Version)." To start and terminate the functions, 
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follow the procedures described in Section 2.1, "Start and Termination (HSSB Version)," and Section 2.2, 
"Start and Termination (Ethernet Version)." 
 

 CNC
     No.1

 CNC
     No.2

 CNC
     No.3

High-speed
serial bus board
No. 1

High-speed
serial bus board
No. 2

Personal computer

Ethernet

 
 

2.2.3 Termination 
The following explains how to terminate the CNC screen display function. 
As explained below, there are several termination methods. You can use any of these methods to 
terminate the CNC screen display function. 
 

Operation 1 
 Terminating from a pop-up menu 
 Click the right button of the mouse on the screen of the CNC screen display function. A pop-up 

menu as shown below appears. Choose [Exit]. 

  
Operation 2 

 Terminating from the menu bar 
 Choose [Exit] from the submenu of [File]. 

  
Operation 3 

 Terminating from the title bar 
 Click . 

  
Operation 4 

 Terminating from the keyboard 
 Press [Alt]+[F4]. 
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 If the function is terminated due to a broken communication rather than by any of the above methods, 

the message below appears. 

  
 To suppress this message, clear [Display communication error] in the submenu of [View]. 

  
 

NOTE 
 During the termination processing for the CNC screen display function, the 

following message appears: 

  

 If the CNC screen display function is restarted while this message is being 
displayed, the CNC screen display function may operate abnormally. 

 When restarting the CNC screen display function, restart the function after the 
above message disappears. 
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2.2.4 Termination by Means of the PMC Signal 
The following explains how to terminate the CNC screen display function by means of the PMC signal. 
 

NOTE 
 This function is not available on Embedded Ethernet for Series 30i/31i/32i-A or 

Series 0i-D. 
 

 
 Not using this function does not influence the operation of the CNC screen display function. Use it 

as required. 
 
Turning on a specified machine signal terminates the CNC screen display function. To specify the 
machine signal, follow the procedure below. 
 

Procedure 
1. Choose the [Close Signal…] from the submenu of [Option] in the menu bar. 

  
2. The Close Signal dialog box appears. 

  
3. Enter the target PMC signal in the Signal on host text box, using the following format, then choose 

the  button. 
 
 <signal-address>.<bit-position>  Example)  X0004.7 
 

 
 The close signal can be specified also using an argument on the command line. 
 The format of the command line specification is as follows: 
 

CNCSCRNE  /S=<signal-address>.<bit-position> 
 
 The /H, /T, /M, and /S arguments can be specified simultaneously. 
 

NOTE 
 The setting of the machine signal is preserved. It is impossible to start the 

CNC screen display function if the set signal is kept turned on with the PMC 
sequence program. 
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2.3 START AND TERMINATION (Personal computer function 
with WindowsCE VERSION) 

This section explains how to start and terminate the CNC screen display function for Series 
160is/180is/210is or Series 30i/31i/32i with the personal computer function with WindowsCE, and 
explains the points to be noted when the function is started. 
 

2.3.1 Start 
The following explains the procedure for starting the CNC screen display function for a CNC of the 
LCD-mounted type that is installed on the main board or a CNC of the stand-alone type that is connected 
with the HSSB, and explains the points to be noted when you start the function. 
 

Procedure 
1. Open the \Storage Card\FANUC\CNCScrn folder. 

  
2. Start CNCScrn.exe. 
 

 
 With NCBOOTis (Series 160is/180is/210is) or NCBOOT32 (Series 30i/31i/32i with the personal 

computer function with WindowsCE), the CNC screen display function can also be automatically 
started at power-on. For more information, refer to any of the following operator’s manuals: 

 - Series 160is/180is/210is-A (A02B-0207-K733#ZZ07) 
  NCBOOTisj.doc 
 - Series 160is/180is/210is-B (A02B-0207-K736#ZZ07) 
  NCBOOTisj.doc 
 - Series 30i/31i/32i-A with the personal computer function with WindowsCE 
  (A08B-9110-J702#ZZ11) or (A08B-9110-J706#ZZ11) or (A08B-9110-J707#ZZ11) 
  NCBOOT32.doc 

- Series 30i/31i/32i-B with the personal computer function with WindowsCE 
 （A08B-9110-J708#ZZ11） 
 NCBOOT32.doc 

 
Showing the title bar 

To show the title bar, perform the following: 
 
1. Press the keys below to display the [View] menu. 
 For Series 160is/180is/210is : [Unlabeled key] + [V] 
 For Series 30i/31i/32i with the personal computer function with WindowsCE : [ALT] + [V] 
2. Select [Title bar] in the [View] menu. 
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Hiding the Windows taskbar 
To hide the Windows taskbar, perform the following: 
 
1. Press the keys below to display the [View] menu. 
 For Series 160is/180is/210is : [Unlabeled key] + [V] 
 For Series 30i/31i/32i with the personal computer function with WindowsCE : [ALT] + [V] 
2. Select [Display above task bar] in the [View] menu. 

  
 

NOTE 
 When the CNC screen display function is started on the Series 

160is/180is/210is, the CNC display screen to be displayed is determined 
according to the following CNC parameters: 

 CNC parameters: Nos. 3198 and 3199 
 (CNC parameter for enabling the above parameters: Bit 6 of parameter No. 

3103) 
 When the CNC screen display function is started on the Series 30i/31i/32i, the 

screen that was selected on the CNC before this function is started remains 
displayed. Likewise, when the CNC screen display function is ended, the screen 
that was displayed by this function is displayed on the CNC. Note that when the 
PMC screen is displayed, the screen of the CNC that was displayed before the 
PMC screen is displayed is displayed. Also, when the CNC screen display 
function is started or ended with the help menu or multi-teaching function pop-up 
menu displayed, these screens are cleared. 

 

2.3.2 Termination 
The following explains how to terminate the CNC screen display function. 
To terminate the CNC screen display function, the same procedure can be used for a CNC of the 
LCD-mounted type that is installed on the main board, a CNC of the stand-alone type that is connected 
with the HSSB, and a CNC that is connected via an Ethernet. 
 

Procedure 
1. Press the keys below to display the [File] menu. 
 For Series 160is/180is/210is : [Unlabeled key] + [F] 
 For Series 30i/31i/32i with the personal computer function with WindowsCE : [ALT] + [F] 
2. Select [Exit] in the [File] menu. 
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2.4 TYPES OF DISPLAYED SCREENS 
This section explains types of displayed screens. 
 
The CNC screen display function can display the following types of screens. 
 

 
 The type of a screen cannot be changed as a rule because it depends on whether a CNC has a 

CNC-dedicated display and which type the display is. 
 
• 10.4-inch display (12-soft key type) 

  
 A standard screen image is shown above. This type of screen appears when the CNC side has a 

CNC-dedicated display for the 10.4-inch image view or when the CNC does not have a 
CNC-dedicated display. 

 
 The screen resolution is 640 × 480 dots (VGA). You can obtain an enlarged screen view of 800 × 

600 dots (SVGA) or 1,024 × 768 dots (XGA) by setting either of the resolutions. See Section 3.3, 
“Setting Screen Resolutions,” for an explanation of how to set a resolution. 

 
 When a CNC in the Series 30i/31i/32i with the personal computer function with WindowsCE has a 

15-inch display, screens can be displayed in 10.4-inch mode by setting the following parameter: 
 
 Set bit 7 of CNC parameter No. 13115 to 1. 
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NOTE 
1 The SVGA/XGA enlarged view capability for a 10.4-inch display can be used for 

CNCs in the Series 16i/18i/21i, Series 160i/180i/210i, Series 30i/31i/32i, Series 
30i/31i/32i /35i, Series 0i-D/F and Power Motion i with the personal computer 
function with WindowsXP. 

 The SVGA enlarged view capability can be used for CNCs in the Series 
160is/180is/210is and Series 30i/31i/32i with the personal computer function 
with WindowsCE. 

 The other models do not support the enlarged view capability. 
 The option for the XGA/SVGA enlarged view capability of the CNC screen 

display function must be provided for a CNC in the Series 16i/18i/21i, Series 
160i/180i/210i, or Series 160is/180is/210is. 

2 You can only obtain SVGA/XGA-size enlarged views of standard CNC/PMC 
screens (including screens created using the C Executor, Macro Executor, or 
PMC C) and MANUAL GUIDE i screens. Interactive screens other than 
MANUAL GUIDE i screens cannot be displayed. 

3 On an SVGA/XGA-size enlarged view of any user-created screens (including 
screens created using the C Executor, Macro Executor, or PMC C), the 
distances between each drawn shapes are not even and some spaces may be 
created between each shapes, and then solid shapes may be distorted. 

4 Fonts of displayed characters depends on which screen size is used, VGA, 
SVGA, or XGA. 

5 An XGA enlarged view does not fill the entire screen. This view is defined by a 
black frame as shown below, which has a total width of 24 dots in the top and 
bottom borders and a total width of 32 dots in the left and right borders. 
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• 9-inch display (7-soft key type) 

  
 This type of screen appears when the CNC side has a CNC-dedicated display for the 9-inch image 

view. Examples of such display are 9-inch CRT displays, 7.2-inch LCDs (monochrome), and 
8.4-inch LCDs. 

 The screen resolution is 640 × 480 dots (VGA). 
 

 
 The 9-inch image view is not supported in a CNC in the Series 15-B, Series 15i, Series 0i-D. 

 
• 15-inch display 

  
 This type of screen can be displayed only for a CNC in the Series 30i/31i/32i/35i, Series 0i-F. The 

screen appears when the CNC side has a CNC-dedicated display for the 15-inch image view. If the 
CNC is of the stand-alone type and does not have a CNC-dedicated display, screens can be 
displayed in 15-inch mode by setting the following parameter: 

  Set bit 0 of CNC parameter No. 13114 to 1. 
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 The screen resolution is 1,024 × 768 dots (XGA). You can obtain an enlarged screen view of 1,280 × 
960 dots (SXGA) by setting either of the resolutions. See Section 3.3, “Setting Screen Resolutions,” 
for an explanation of how to set a resolution. 

 
NOTE 
1 If the resolution of the CNC screen display function is higher than that of the 

monitor of your personal computer, screens cannot be displayed properly. In this 
case, regions lying off screen are clipped and not displayed. 

2 The SXGA enlarged view capability for a 15-inch display can be used for CNCs 
in the Series 30i/31i/32i/35i, Series 30i/31i/32i/35i with the personal computer 
function with WindowsXP. 

 The option for the 19-inch enlarged view capability of the CNC screen display 
function must be provided for a CNC. 

3 On an SVGA/XGA-size enlarged view of any user-created screens (including 
screens created using the C Executor, Macro Executor, or PMC C), the 
distances between each drawn shapes are not even and some spaces may be 
created between each shapes, and then solid shapes may be distorted. 

4 Fonts of displayed characters depends on which screen size is used, VGA, 
SVGA, or XGA. 

5 An SXGA enlarged view does not fill the entire screen. This screen height is 64 
dots less than the height of SXGA screen. 

 
• 19-inch display 

  
 This type of screen can be displayed only for a CNC in the Series 30i/31i/32i with the personal 

computer function with WindowsXP. Screens can be displayed in 19-inch mode by setting the 
following parameter. 

 
  Set bit 1 of CNC parameter No. 13114 to 1. 
 
 The screen resolution is 1,280 × 768 dots (WXGA). 
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NOTE 
1 If the resolution of the CNC screen display function is higher than that of the 

monitor of your personal computer, screens cannot be displayed properly. In this 
case, regions lying off screen are clipped and not displayed. 

2 The 19-inch display can be used for CNCs in the Series 30i/31i/32i with the 
personal computer function with WindowsXP. 

 The option for the CNC screen display for 19" LCD must be provided for a CNC. 
 

2.5 INPUT FROM THE KEYBOARD 
This section explains the key input method. 
 
• Input from the MDI keyboard (Series 160i/180i/210i, Series 160is/180is/210is, 

Series 30i/31i/32i/35i, Power Motion i with the personal computer function with WindowsXP, 
Series 30i/31i/32i with the personal computer function with WindowsCE, Series 0i-B/D and Series 
150i) 

 The CNC MDI keys, with some exceptions, can be used in the manner described in the CNC 
operator's manual. 

 For the CNC screen display function, the key codes for another personal computer may be assigned 
to the MDI keys. To perform MDI key operations below, use the corresponding alternative keys. 

 
 For Series 160i/180i/210i, Series 160is/180is/210is or Series 0i-B 

MDI key Key used in the CNC screen display 
function 

Alternative key of function 
key 

[CUSTOM] [Ctrl] [SHIFT]+[POS] 
Unlabeled (or [FAPT]) [Alt] [SHIFT]+[PROG] 

 
For Series 30i/31i/32i/35i with the personal computer function with WindowsXP, Series 30i/31i/32i, 
Power Motion i with the personal computer function with WindowsCE or Series 0i-D/F 

MDI key Key used in the CNC screen display 
function 

Alternative key of function 
key 

[SHIFT]+[1] ! [SHIFT]+[F1] 
[SHIFT]+[2] " [SHIFT]+[F2] 
[SHIFT]+[3] ^ [SHIFT]+[F3] 
[SHIFT]+[4] $ [SHIFT]+[F4] 
[SHIFT]+[5] % [SHIFT]+[F5] 

 
 For Series 150i 

MDI key Key used in the CNC screen display 
function 

Alternative key of function 
key 

[CUSTOM] [Ctrl] [SHIFT]+[POS] 
Unlabeled (or [FAPT]) [Alt] [SHIFT]+[PROG] 
[SHIFT]+[1] ! [SHIFT]+[F1] 
[SHIFT]+[2] " [SHIFT]+[F2] 
[SHIFT]+[3] ^ [SHIFT]+[F3] 
[SHIFT]+[4] $ [SHIFT]+[F4] 
[SHIFT]+[5] % [SHIFT]+[F5] 
[SHIFT]+[6] ~ [SHIFT]+[F6] 
[SHIFT]+[7] ' [SHIFT]+[F7] 
[SHIFT]+[8] < [SHIFT]+[F8] 
[SHIFT]+[9] > [SHIFT]+[F9] 
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NOTE 
 Pressing the [SHIFT] key instigates processing within the personal computer. It 

is not transferred to the CNC. Therefore, the functions performed by using the 
[SHIFT] key cannot be used. 

 Example: [SHIFT] . . . . . . Screen copy 
 
• Input from the PS/2 full keyboard or USB full keyboard 
 Those keys not found on the MDI keyboard, with the exception of the alphanumeric keys, are 

assigned as follows: 
 
 For Series 16i/18i/21i, Series 160i/180i/210i, Series 160is/180is/210is, Series 0i-B/C, or 

Power Mate i 
Full keyboard  Corresponding key on the MDI keyboard 

[Insert] → [INSERT] 
[Delete] → [DELETE] 
[Home] → [ALTER] 
[End] → [HELP] 
[Page Up] → [↑PAGE] 
[Page Down] → [↓PAGE] 
[Esc] → [HELP] 
[Tab] → [ALTER] 
[Ctrl]+[F1]or [1] on numeric keypad → [POS] 
[Ctrl]+[F2] or [2] on numeric keypad → [PROG] 
[Ctrl]+[F3] or [3] on numeric keypad → [OFFSET/SETTING] 
[Ctrl]+[F4] or [4] on numeric keypad → [SYSTEM] 
[Ctrl]+[F5] or [5] on numeric keypad → [MESSAGE] 
[Ctrl]+[F6] or [6] on numeric keypad → [GRAPH] 
[Ctrl]+[F7] or [7] on numeric keypad → [CUSTOM] 
[Ctrl]+[F8] or [8] on numeric keypad → Unlabeled (or [FAPT]) 
[F1] to [F10] → Relative position soft keys 
[F11] → [FL] (leftmost soft key) 
[F12] → [FR] (rightmost soft key) 

 
 For Series 30i/31i/32i/35i, Series 0i-D/F or Power Motion i 

Full keyboard  Corresponding key on the MDI keyboard 
[Insert] → [INSERT] 
[Delete] → [DELETE] 
[Home] → [ALTER] 
[End] → [HELP] 
[Page Up] → [↑PAGE] 
[Page Down] → [↓PAGE] 
[Esc] → [HELP] 
[Tab] → [ALTER] 
[Ctrl]+[F1]or [1] on numeric keypad → [POS] 
[Ctrl]+[F2] or [2] on numeric keypad → [PROG] 
[Ctrl]+[F3] or [3] on numeric keypad → [OFFSET/SETTING] 
[Ctrl]+[F4] or [4] on numeric keypad → [SYSTEM] 
[Ctrl]+[F5] or [5] on numeric keypad → [MESSAGE] 
[Ctrl]+[F6] or [6] on numeric keypad → [GRAPH] 
[Ctrl]+[F7] or [7] on numeric keypad → [CUSTOM1] 
[Ctrl]+[F8] or [8] on numeric keypad → [CUSTOM2] 
[F1] to [F10] → Relative position soft keys 
[F11] → [FL] (leftmost soft key) 
[F12] → [FR] (rightmost soft key) 
[Shift]+[Home] or [Tab] → [CALC] 
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 For Series 15i or Series 150i 
Full keyboard  Corresponding key on the MDI keyboard 

[Insert] → [INSERT] 
[Delete] → [DELETE] 
[Home] → [ALTER] 
[End] → [HELP] 
[Page Up] → [↑PAGE] 
[Page Down] → [↓PAGE] 
[Esc] → [HELP] 
[Tab] → [ALTER] 
[Ctrl]+[F1]or [1] on numeric keypad → [POS] 
[Ctrl]+[F2] or [2] on numeric keypad → [PROG] 
[Ctrl]+[F3] or [3] on numeric keypad → [OFFSET/SETTING] 
[Ctrl]+[F4] or [4] on numeric keypad → [SYSTEM] 
[Ctrl]+[F5] or [5] on numeric keypad → [MESSAGE] 
[Ctrl]+[F6] or [6] on numeric keypad → [GRAPH] 
[Ctrl]+[F7] or [7] on numeric keypad → [CUSTOM] 
[Ctrl]+[F8] or [8] on numeric keypad → Unlabeled (or [FAPT]) 
[F1] to [F10] → Relative position soft keys 
[F11] → [FL] (leftmost soft key) 
[F12] → [FR] (rightmost soft key) 

 
 For Series 150-B 

Full keyboard  Corresponding key on the MDI keyboard 
[Insert] → [INPUT] 
[Delete] → [DELETE] 
[Home] → [ALTER] 
[End] → [HELP] 
[Page Up] → [↑PAGE] 
[Page Down] → [↓PAGE] 
[Ctrl]+[F1]or [1] on numeric keypad → [POS] 
[Ctrl]+[F2] or [2] on numeric keypad → [PROG] 
[Ctrl]+[F3] or [3] on numeric keypad → [OFFSET] 
[Ctrl]+[F4] or [4] on numeric keypad → [P-CHECK] 
[Ctrl]+[F5] or [5] on numeric keypad → [SETTING] 
[Ctrl]+[F6] or [6] on numeric keypad → [SERVICE] 
[Ctrl]+[F7] or [7] on numeric keypad → [MESSAGE] 
[Ctrl]+[F8] or [8] on numeric keypad → [OTHERS] 
[Ctrl]+[F9]] or [9] on numeric keypad → [CNC/PMC] 
[Ctrl]+[F10]] or [0] on numeric keypad → [FAPT] 
[Ctrl]+[F11] → [AUX] 
[F1] to [F10] → Relative position soft keys 
[F11] → [FL] (leftmost soft key) 

 
NOTE 
1 The [RESET] MDI key is not assigned to the full keyboard to prevent possible 

problems. When using the [RESET] key, use that on the MDI keyboard. (The 
[RESET] MDI key is effective even when the CNC screen display function is 
being executed.) 

2 The key assignment of the full keyboard can be changed. For an explanation of 
how to change the key assignment, see Section 3.6. 
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2.6 INPUT WITH THE MOUSE AND TOUCH PANEL 
This section explains input with the mouse and touch panel. 
 

Operation 1 
 Click a soft key or a virtual MDI keyboard by using the mouse . 
 
 For Series 16i/18i/21i and Series 160i/180i/210i 

  

Operation 2 
 Physically press a soft key or a virtual MDI keyboard on the touch panel. 
 

NOTE 
 Within a CNC screen, the mouse and touch panel can be used only for the 

operations of a soft key and a virtual MDI keyboard. 
 

2.7 FUNCTION KEYS 
This section explains how to select function keys by using the full keyboard and mouse. 
 
• When the full keyboard is used 
 The function keys on the MDI keyboard are assigned to the full keyboard as follows: 
 
 For Series 16i/18i/21i, Series 160i/180i/210i, Series 160is/180is/210is, Series 0i-B/C, Series 15i, 

Series 150i, or Power Mate i 
Full keyboard  Function key on the MDI keyboard 

[POS] → [1] on numeric keypad or [Ctrl]+[F1] 
[PROG] → [2] on numeric keypad or [Ctrl]+[F2] 
[OFFSET/SETTING] → [3] on numeric keypad or [Ctrl]+[F3] 
[SYSTEM] → [4] on numeric keypad or [Ctrl]+[F4] 
[MESSAGE] → [5] on numeric keypad or [Ctrl]+[F5] 
[GRAPH] → [6] on numeric keypad or [Ctrl]+[F6] 
[CUSTOM] → [7] on numeric keypad or [Ctrl]+[F7] 
Unlabeled (or [FAPT])  → [8] on numeric keypad or [Ctrl]+[F8] 

 
 For Series 30i/31i/32i/35i, Series 0i-D/F or Power Motion i 

Full keyboard  Function key on the MDI keyboard 
[POS] → [1] on numeric keypad or [Ctrl]+[F1] 
[PROG] → [2] on numeric keypad or [Ctrl]+[F2] 
[OFFSET/SETTING] → [3] on numeric keypad or [Ctrl]+[F3] 
[SYSTEM] → [4] on numeric keypad or [Ctrl]+[F4] 
[MESSAGE] → [5] on numeric keypad or [Ctrl]+[F5] 
[GRAPH] → [6] on numeric keypad or [Ctrl]+[F6] 
[CUSTOM1] → [7] on numeric keypad or [Ctrl]+[F7] 
[CUSTOM2] → [8] on numeric keypad or [Ctrl]+[F8] 

 



2.OPERATION  B-63164EN/11 

- 38 - 

 For Series 150-B 
Full keyboard  Function key on the MDI keyboard 

[POS] → [1] on numeric keypad or [Ctrl]+[F1] 
[PROG] → [2] on numeric keypad or [Ctrl]+[F2] 
[OFFSET] → [3] on numeric keypad or [Ctrl]+[F3] 
[P-CHECK] → [4] on numeric keypad or [Ctrl]+[F4] 
[SETTING] → [5] on numeric keypad or [Ctrl]+[F5] 
[SERVICE] → [6] on numeric keypad or [Ctrl]+[F6] 
[MESSAGE] → [7] on numeric keypad or [Ctrl]+[F7] 
[OTHERS] → [8] on numeric keypad or [Ctrl]+[F8] 

 
• When the mouse is used 

1. Choose the [Function key] from the submenu of [View] on the menu bar. 

  
 

 
 When a CNC in the personal computer function with WindowsCE version is used, choose a 

menu item by performing the following key operation. 
(1) Press the keys below to display the [View] menu. 
  For Series 160is/180is/210is : [Unlabeled key] + [V]  
  For Series 30i/31i/32i with the personal computer function with WindowsCE :  

          [ALT] + [V] 
(2) Select [Function key] in the [View] menu.  

 
2. The function switch screen appears. Choose the button of a desired screen. 
 
 Series 16i/18i/21i, Series 160i/180i/210i  
 Series 160is/180is/210is, Series 0i-B/C  Series 0i-D/F 

Series 15i     Series 30i/31i/32i/35i 
Series 150i, Power Mate i    Power Motion i 

     
 

Button  Key on MDI keyboard Button  Key on MDI keyboard 

 
→ [POS] 

 
→ [POS] 

 
→ [PROG] 

 
→ [PROG] 

 
→ [OFFSET/SETTING] 

 
→ [OFFSET/SETTING] 

 
→ [CUSTOM] 

 
→ [CUSTOM1] 

 
→ [SYSTEM] 

 
→ [SYSTEM] 
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Button  Key on MDI keyboard Button  Key on MDI keyboard 

 
→ [MESSAGE] 

 
→ [MESSAGE] 

 
→ [GRAPH] 

 
→ [GRAPH] 

 
→ [FAPT] 

 
→ [CUSTOM2] 

 
NOTE 
 The  button appears when conversational automatic programming function 

II for lathe is provided. 
 

 Series 150-B 

   
 

Button  Key on MDI keyboard 

 
→ [POS] 

 
→ [PROG] 

 
→ [OFFSET] 

 
→ [P-CHECK] 

 
→ [SETTING] 

 
→ [SERVICE] 

 
→ [MESSAGE] 

 
→ [OTHRES] 

 
NOTE 
 The function switch screen appears at the center of the screen for the first time. 

Move the screen to any desired location. When the screen is displayed for the 
second and subsequent times, the screen appears at the location to which the 
screen was moved previously. 
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2.8 DATA INPUT/OUTPUT 
This section explains data input/output operations (input to and output from the memory card and hard 
disk). 
 

NOTE 
 This function cannot be used with CNCs in the Series 150-B. 

 
When you use a CNC in the Series 160i/180i/210i with the personal computer function, or an 
LCD-mounted-type CNC in the Series 160is/180is/210is or an LCD-mounted-type CNC in the Series 
30i/31i/32i with the personal computer function with WindowsCEa memory card in the PCMCIA slot at 
the front is connected to Windows side, rather than the CNC side. It is the same situation with the USB 
memory on the Series 30i/31i/32i-B with the personal computer function with WindowsCE. The memory 
card or USB memory is thus handled as a kind of drive or folder (removable disk) connected to Windows. 
To use a memory card for input/output, set up the following parameters. 
 Set CNC parameter No. 20 to 4. 
To use a USB memory for input/output, set up the following parameters. 
 Set CNC parameter No. 20 to 17. 
 
When you use a personal computer connected using a high-speed serial bus or Ethernet board to the CNC 
or you use the display unit(with WindowsCE) for the stand-alone-type CNC, a memory card is connected 
to the CNC side. In this case, input/output operations for the memory card are applied to the CNC, rather 
than Windows. 
However, a folder on the Windows side can be specified as the data input/output destination by setting the 
following parameter: 

- For Series 16i/18i/21i, Series 160i/180i/210i, Series 160is/180is/210is, Series 30i/31i/32i/35i, 
Series 0i-B/C/D/F or Power Motion i : 

  Set CNC parameter No. 20 to 4. 
  Set CNC parameter No. 0300 bit 0 to 1. 
- For Series 15i or Series 150i : 
  Set CNC parameters No. 20 to No. 23 to 0 or 8. 
  Set CNC parameter No. 7713 bit 2 to 1. 
- For Power Mate i : 
  Set CNC parameter No. 20 to 4. 
  Set CNC parameter No. 0300 bit 7 to 0. 

 
This can change all input/output operations for the memory card connected to the CNC to input/output 
operations for the folder on the Windows side. 
 
And also about USB memory, when the USB memory exists on the CNC side, the input/output operations 
to the USB memory by the CNC screen display function connected with high-speed serial bus are applied 
to the CNC, rather than Windows. 
However, a folder on the Windows side can be specified as the data input/output destination by setting the 
following parameter: 

- For Series 30i/31i/32i/35i-B, Series 0i-F or Power Motion i: 
  Set CNC parameter No. 20 to 17. 
  Set CNC parameter No. 11506 bit 0 to 1. 

 
NOTE 
 In case of Ethernet connection, the input/output operation to the USB memory 

cannot be switched from the CNC side to the folder on the Windows. 
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Assignment to a memory card drive/folder 
The actual drive and folder to which the memory card is assigned depends on the configuration on the 
Windows side. Set the drive and folder to which the memory card has been assigned, as described below. 
The following explanation uses an example where the memory card has been assigned to the root folder 
of the D drive. 
 
1. Choose [Data input/output...] from the submenu of [File] in the menu bar. 

  
 

 
 When a CNC in the personal computer function with WindowsCE version is used, choose a menu 

item by performing the following key operation. 
 (1) Press the keys below to display the [File] menu. 
  For Series 160is/180is/210is : [Unlabeled key] + [F] 
  For Series 30i/31i/32i with the personal computer function with WindowsCE : [ALT] + [F] 
 (2) Select [Data input/output...] in the [File] menu. 
 
2. The [Data Input/Output] dialog box appears. 

  
3. Enter the memory card drive (D:\), then click the <OK> button. 

  
 When the <Browse> button is pressed on the above screen, the [Browse for Folder] dialog box 

appears. Choose an appropriate folder, then click the <OK> button. Then, a folder name can be 
entered. 
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 After the above steps have been completed, every memory card I/O operation by the CNC is 

performed for the memory card (D:\) on the Windows. 
 

Assignment to a USB memory 
In Series 30i/31i/32i/35i-B, Series 0i-F or Power Motion i, the I/O destination can be assigned to USB 
memory as well as the memory card drive. The I/O destination for assignment to a USB memory should 
be specified into the edit box under the "USB Memory"-label on the following dialog.  
 

  
 

Assignment to a hard disk 
The I/O destination can be assigned to a hard disk as well as the memory card drive. Assignment to a hard 
disk is performed in the same way as for a memory card drive. A drive may be specified directly, or a 
subfolder may be specified. Once the assignment is completed, the CNC data is input to or output from 
the folder. 
Any of the folders in the Windows file system, including the memory card, hard disk, floppy disk, and 
drives connected through a network, can be assigned. 
The contents of an assigned I/O folder can be checked on the CNC screen. 
 

 
 For a CNC in the personal computer function with WindowsCE version, a Compact Flash card is 

mounted instead of a hard disk. Therefore, set the data input/output destination as shown below. 
 \Storage Card\…\… (…: folder name) 
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  “SYSTEM” / “ALL-IO” screen (Series 16i/18i/21i) 
 
 Shown above is a sample screen displayed when the following folder (C:\NCDATA) is assigned. 

The O numbers below [PROGRAM] indicate the program names contained in memory in the CNC. 
 

Hard disk in the Windows CNC internal memory 
C:\NCDATA\O0010.TXT (file) 
       \FOLDER (folder) 

O0001 
O0020 

 
NOTE 
1 When a subfolder is specified as an I/O folder, "." or ".." is indicated. FOLDER 

indicates a folder name. Any I/O operation for these folders results in an error. 
2 Only uppercase alphanumeric characters can be displayed on the CNC screen. 

Any lowercase characters included in folder names on the Windows are 
converted to uppercase when displayed. Kana and kanji characters are not 
displayed correctly. 
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2.9 CLEARING ALARMS 
This section explains how to clear CNC alarms that may appear at power-on. 
 

NOTE 
 This function cannot be used with CNCs in the personal computer function with 

WindowsCE version, Series 15i, Series 150i, or Series 150-B. 
 
For the CNC screen display function, multiple keys cannot be pressed at the same time. Use menus to 
clear CNC alarms as described below. 
 
For Series 16i/18i/21i, Series 160i/180i/210i, Series 0i-B/C, or Power Mate i 

Alarm number  Key on the MDI keyboard for clear operation 
PS000 → [RESET]+[CAN] 
PS101 → [RESET]+[PROG] 

 
For Series 30i/31i/32i/35i, Series 0i-D/F or Power Motion i 

Alarm number  Key on the MDI keyboard for clear operation 
SW000 → [RESET]+[CAN] 

 
To clear CNC alarms, perform the following: 
 

Operation 1 
 Clearing from a pop-up menu 
 Click the right mouse button on the screen of the CNC screen display function. 
 A pop-up menu as shown below appears. Choose [Alarm clear] and then select the desired alarm in 

the submenu of [Alarm clear]. 

  
Operation 2 

 Clearing from the menu bar 
 Choose [Alarm clear] in the submenu of [Option] on the menu bar and then select the desired alarm 

in the submenu of [Alarm clear]. 
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2.10 COPYING SCREENS 
This section explains how to produce file output of CNC screen images displayed by the CNC screen 
display function, as bitmap data (BMP file). 
 

Operation procedure 
1. Select [Capture] in the [File] menu. 

  
 

 
 When a CNC in the personal computer function with WindowsCE version is used, choose a 

menu item by performing the following key operation. 
 (1) Press the keys below to display the [File] menu. 
  For Series 160is/180is/210is : [Unlabeled key] + [F] 
  For Series 30i/31i/32i with the personal computer function with WindowsCE : 
           [ALT] + [F] 
 (2) Select [Capture] in the [File] menu. 

 
2. Copying completes when the hourglass disappears. 
 

Notes 
• The output destination of bitmap data is the same as the data input/output destination described in 

Section 2.8. 
• A bitmap file is named HDCPY001.BMP. 
 When two or more bitmap files are output, they are named as shown below. 
 HDCPY001.BMP, HDCPY002.BMP, HDCPY003.BMP, … 
 Bitmap files are automatically serial-numbered after HDCPY in an incremental manner until the 

CNC screen display function is terminated. When the CNC screen display function is restarted, 
bitmap files are serial-numbered, starting at HDCPY001.BMP again. The previous bitmap files are 
overwritten. 

• A screen image is output as 256-color bitmap data. A bitmap file for 10.4-inch view has a size of 
approximately 300 KB and is output in approximately 4 seconds. 

• Bitmap data does not contain pull-down menus and the hourglass. 
• Blinking characters and cursor cannot be output properly. 
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2.11 DISPLAYING VERSION INFORMATION 
This section explains how to display information used for maintenance such as version information of the 
CNC screen display function. 
 

Operation procedure 
1. Choose [About...] from the submenu of [Help] in the menu bar. 

  
 

 
 When a CNC in the personal computer function with WindowsCE version is used, choose a 

menu item by performing the following key operation. 
 (1) Press the keys below to display the [Help] menu. 
  For Series 160is/180is/210is : [Unlabeled key] + [H] 
  For Series 30i/31i/32i with the personal computer function with WindowsCE : 
           [ALT] + [H] 
 (2) Select [About] in the [Help] menu. 

 
2. The About CNC Screen Display Function appears. 

  
 The displayed information includes: 
 • Information about the version of the CNC screen display function 
 • CNC type 
 • CNC software series 
 • CNC software version 
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3 SETTING 
This chapter explains the settings for the CNC screen display function. 
 
Chapter 3, “SETTING”, consists of the following sections: 
 

3.1 SWITCHING BETWEEN LOCATIONS TO SAVE THE SETTINGS 47 
3.2 SWITCHING BETWEEN DISPLAY LANGUAGES 48 
3.3 SETTING SCREEN RESOLUTIONS 49 
3.4 SETTING THE DISPLAY TIMING AT STARTUP 50 
3.5 SETTING ANIMATED SIMULATION FOR TURNING 51 
3.6 CHANGING KEYBOARD ASSIGNMENT 52 

 

3.1 SWITCHING BETWEEN LOCATIONS TO SAVE THE 
SETTINGS 

This section explains how to switch between locations to save the settings. 
 

NOTE 
 This function cannot be used with CNCs in the personal computer function with 

WindowsCE version. 
 
You can choose whether to save the settings for the CNC screen display function, including display 
languages and display languages, in different locations for different connections, or to save the settings in 
a common location. To change the location to save the settings, perform the following: 
 
1. Choose [Setting] in the submenu of [Option] on the menu bar. 

  
2. The setting screen appears. In the selection list on the screen, select a listed connection destination 

(<Node1> in an example below) to save the settings in different locations for different connections, 
or select <Common> to save the settings in a common location. Then, click the <OK> button. 
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3.2 SWITCHING BETWEEN DISPLAY LANGUAGES 
This section explains how to switch from one display language to another. 
 
To switch between display languages, use the following procedure (where, an example for switching from 
English to Japanese is given): 
 
1. Choose [Setting...] from the submenu of [Option] on the menu bar. 

  
 

  
 When a CNC in the personal computer function with WindowsCE version is used, choose a 

menu item by performing the following key operation. 
  (1) Press the keys below to display the [Option] menu. 
   For Series 160is/180is/210is : [Unlabeled key] + [O] 
   For Series 30i/31i/32i with the personal computer function with WindowsCE : 
            [ALT] + [O] 
  (2) Select [Setting] in the [Option] menu. 
 
2. The Setting screen appears. Choose [Language]. Choose the language you want to use, then choose 

the <OK> button. 

  
3. The following message appears. Choose the <OK> button, then restart the CNC screen display 

function. 

  
 



B-63164EN/11  3.SETTING 

- 49 - 

NOTE 
1 Switching display languages in the CNC screen display function changes only 

the language of the displayed items specific to the CNC screen display 
function, such as the title bar, menu bar, and pop-up menus. The CNC screen 
display part is displayed in the specified CNC display language. 

2 When a language with a font not supported by Windows is selected, the 
language cannot be displayed correctly. Set a display language supported by 
Windows. 

 

3.3 SETTING SCREEN RESOLUTIONS 
This section explains how to set a screen resolution. 
 
When the CNC screen is the 10.4-inch view, you can change the standard resolution of 640 × 480 dots 
(VGA) to 800 × 600 dots (SVGA) or 1,024 × 768 dots (XGA) to obtain an enlarged view.  
Or, When the CNC screen is the 15-inch view, you can change the standard resolution of 1,024 × 768 
dots (XGA) to 1,280 × 960 dots (SXGA) to obtain an enlarged view. 
 

NOTE 
 The enlarged view capability is not enabled in all models. There is a limitation on 

the types of screens for which enlarged views can be obtained. See Section 2.4, 
“Types of Displayed Screens, ” for an explanation of the specifications and 
limitations for the enlarged view. 

 
To change the screen resolution, perform the following: 
 
1. Choose [Setting…] in the submenu of [Option] on the menu bar. 

     
  

  
 When a CNC in the personal computer function with WindowsCE version is used, choose a 

menu item by performing the following key operation. 
  (1) Press the keys below to display the [Option] menu. 
   For Series 160is/180is/210is : [Unlabeled key] + [O] 
   For Series 30i/31i/32i with the personal computer function with WindowsCE : 
            [ALT] + [O] 
  (2) Select [Setting] in the [Option] menu. 
 



3.SETTING  B-63164EN/11 

- 50 - 

2. The setting screen appears. Select [Screen]. Select the desired resolution and click the <OK> button. 

  
3. The following message appears. Click the <OK> button, and then restart the CNC screen display 

function. 

  
 

3.4 SETTING THE DISPLAY TIMING AT STARTUP 
This section explains how to change the timing at which the CNC screen display function is displayed in 
the foreground at startup. 
 

NOTE 
 This function cannot be used with CNCs in the personal computer function with 

WindowsCE version. 
 
When you start the CNC screen display function and a user application virtually simultaneously, which 
application is operational as a foreground window is unpredictable. You can set timing at which the CNC 
screen display function is always displayed in the foreground, without having to making changes to the 
user application. 
 
To change the timing setting, perform the following: 
 
1. Choose [Setting] in the submenu of [Option] on the menu bar. 

  
2. The setting screen appears. Select [Startup]. 
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 To display the CNC screen display function as a foreground window after startup, select 
<Foreground>. In <Delay time>, enter a time interval, in milliseconds, from when the function is 
started and to when it is displayed as a foreground window. 

 
NOTE 
 When you select <Foreground>, enter a number of 1 or greater in <Delay 

time>. If the delay time is 0, the setting for displaying the function in foreground 
becomes disabled. 

 
 After entering a value, click the <OK> button. 
 

3.5 SETTING ANIMATED SIMULATION FOR TURNING 
This section explains how to set the data for animated simulation for turning. 
The setting screen is displayed for the Series 16i/18i/21i-T, Series 160i/180i/210i-T, and Series 
160is/180is/210is-T (including the two-path control function).  
 

NOTE 
 This setting will be enabled in the future when the CNC screen display function 

supports the Super CAP T/Super CAPi T, CAPI, and CAPII/Symbol CAPi T. 
 
To modify the data for animated simulation for turning, use the procedure explained below. 
 
1. Choose [Setting...] from the submenu of [Option] on the menu bar. 

  
2. The Setting screen appears. Select [Lathe animation]. Set the display speed of animated simulation 

for turning, then choose the <OK> button. 

  
 

NOTE 
 The display speed of animated simulation for turning is indicated as a number 

of dots. The display is refreshed each time the tool moves the specified number 
of dots. The lower the speed, the smoother the animation appears. 
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3.6 CHANGING KEYBOARD ASSIGNMENT 
This section explains the assignment of the MDI keys to the full keyboard. 
Changes in keyboard assignment are reflected to the key definition file (keymat file) in the directory 
where the CNC screen display function has been installed. This file is installed as read-only. Before 
modifying its contents, change the file attribute. 
 

Changing an assignment 
To change the standard assignment, use the procedure explained below. In the explanation, an example 
for changing from [Ctrl]+[Num-9] to [PROG] is used. 

 
1. Choose [Keyboard...] from the submenu of [Option] on the menu bar. 

  
 

  
 When a CNC in the personal computer function with WindowsCE version is used, choose a 

menu item by performing the following key operation. 
 (1) Press the keys below to display the [Option] menu. 
  For Series 160is/180is/210is : [Unlabeled key] + [O] 
  For Series 30i/31i/32i with the personal computer function with WindowsCE : 
           [ALT] + [O] 
 (2) Select [Keyboard] in the [Option] menu. 
 

2. A list of the current assignments is displayed on the Keyboard Setup screen, as follows: 
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3. Choose a desired key (Num-9) of the full keyboard from the list or the list in the combo box. 

  
4. When the selected key is to be pressed together with the [Ctrl] key, check the attribute item. 

  
5. Select the corresponding MDI key (PROG) from the combo box. 

  
6. Click the  button. 
 

Deleting an assignment 
To delete an assignment, use the procedure explained below. In the explanation, an example of deleting 
the [Delete] key is used. As the result of this deletion example, the full keyboard has no key that functions 
as the [DELETE] MDI key. 
 
1. Choose [Keyboard...] from the submenu of [Option] on the menu bar. 
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2. A list of the current assignments is displayed on the Keyboard setup screen, as follows: 

  
3. Choose the full-keyboard key (Delete) you want to delete from the list. 

  
4. Click the  button. 
 

Notes on changing the keyboard assignment 
 CAUTION 

 When both the full keyboard and MDI keyboard are to be used, do not change 
the assignment. If the setting of a key common to an MDI key is changed, the 
MDI key assignment is also changed at the same time. 

 
NOTE 
 The result of editing (modification and deletion) is reflected by clicking the <OK> 

button. Clicking the <Cancel> button cancels the edit result, restoring the status 
existing before the editing. 
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A ALARMS 
The alarms generated by the CNC screen display function are explained below. 
 
CNC link failed. 
Explanation There is no response from the CNC. 

Action 

(1) Check whether the power to the CNC is turned on. 
(2) When the personal computer or display unit is connected using a high-speed 

serial bus, check whether the cables are connected correctly. 
(3) Check whether driver installation, setting, and other operations performed before 

the installation of the CNC screen display function are correct. 
(4) For a personal computer connected to the CNC via the Ethernet, check its 

network setting and connection. 
 
Function is already in use with another PC. 

Explanation 
The CNC screen display function has already been executed from another personal 
computer or display unit. 

Action 
Only one instance of the CNC screen display function can be started for each CNC at one 
time. After the CNC screen display function has been terminated on another personal 
computer or display unit, try starting the function again. 

 
Restart this application to restore this setting. 
Explanation This alarm is generated when switching between display languages has been performed. 
Action Restart the CNC screen display function. 

 
Font pattern file (%s) open failed. 
Explanation The font pattern file indicated by %s does not exist. 

Action 
The font pattern file must be placed in the same folder as the executable file of the CNC 
screen display function (CNCScrn.exe). Copy the font file to the folder containing the 
executable file. If the font file does not exist, re-install the CNC screen display function. 

 
Font pattern file (%s) is invalid. 
Explanation The font pattern file indicated by %s is destroyed. 
Action Re-install the CNC screen display function. 

 
Keyboard allocation file (Keymatrx.dat) open failed. 
Explanation The keyboard assignment file does not exist. 

Action 

The keyboard assignment file must be placed in the same folder as the executable file of 
the CNC screen display function (CNCScrn.exe or CNCScrnE.exe). Copy the keyboard 
assignment file to the folder containing the executable file. If the keyboard assignment file 
does not exist, re-install the CNC screen display function. 

 
Keyboard assignment file (%S) is write-protected. 

Explanation 
The save setup results cannot be saved as the file attributes for the keyboard assignment 
file to be displayed by %s are read-only. 

Action Change the file attributes, and cancel read-only. 
 
Function key assignment file (%s) open failed; 
Explanation The function key assignment file does not exist. 

Action 

The function key assignment file to be displayed by %s must be in the same folder as the 
execution file (CNCScrn.exe) of the CNC screen display function. Copy the function key 
assignment file to the same folder as the execution file. 
When there is no function key assignment file, re-install the CNC screen display function. 
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Key definition assignment file (%s) open failed. 
Explanation The key definition file does not exist. 

Action 

The key definition file to be displayed by %s must be in the same folder as the execution 
file (CNCScrn.exe) of the CNC screen display function. Copy the key definition file to the 
same folder as the execution file. 
When there is no function key assignment file, re-install the CNC screen display function. 

 
Please select folder. 
Explanation No folder is selected in data I/O setting. 
Action Set a correct folder. 

 
Folder is not chosen. 
Explanation No folder is set in data I/O setting. 
Action Set a correct folder. 

 
The folder does not exist or invalid folder name. 
Explanation A nonexistent folder or an invalid folder name was set in data I/O setting. 
Action Set a correct folder. 

 
CNC Option is not found ! Option Name: Extension Driver/Library Function. 
Explanation The CNC extension driver/library function option is not found. 
Action Purchase the option. 

 
CNC Option is not found ! Option Name: CNC Screen Display Function. 
Explanation The CNC screen display function option for the CNC is not found. 
Action Purchase the option. 

 
CNC type differs from HSSB device set value. 
Explanation The CNC Type of the HSSB device set value differs from the connected CNC. 

Action 
Change the CNC Type of the HSSB device set value to the same Type as the connected 
CNC. 

 
CNC not supported by CNC screen display function is connected. 
Explanation A CNC not supported by the CNC screen display function is connected. 
Action Change the CNC, or consider discontinued use of the CNC screen display function. 

 
Enter host name or IP address. 

Explanation 
Neither a host name nor IP address is specified in the destination specification dialog box 
of the Ethernet version. 

Action Specify the correct host name or IP address. 
 
Enter port number. 

Explanation 
No target CNC port number is specified in the destination specification dialog box of the 
Ethernet version. 

Action Specify the correct port number. 
 
Enter a timeout value. 

Explanation 
No communication timeout value is specified in the destination specification dialog box of 
the Ethernet version. 

Action Specify a timeout value (in seconds). 
 



B-63164EN/11 APPENDIX A.ALARMS 

- 59 - 

%s is not found. 
Explanation An attempt to connect to a CNC having a host name or IP address indicated with %s failed.

Action 

(1) Check that the CNC is supplied with power. 
(2) Check the setting of the FANUC Ethernet board. 
(3) Check the TCP/IP setting in the personal computer. 
(4) Check the network connection. 
(5) If the CNC to be connected has been specified using a host name, check the setting of 

the HOSTS file and DNS server. Alternatively, try to connect using an IP address. 
 
The signal setting is invalid. 
Explanation No close signal is set in the Close Signal dialog box of the Ethernet version. 
Action Specify the correct close signal. 
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B ETHERNET VERSION 
COMMUNICATION LOG 
FUNCTION 

B ETHERNET VERSION COMMUNICATION 
LOG FUNCTION 

This appendix describes the communication log function, which is unique to the Ethernet version of the 
CNC screen display function. 
 
If an error occurs within the CNC screen display function, the communication log function is used to save 
the information about the cause of the error to a file for early problem solving. 
 
The output of the CNC screen display function can be specified using four different levels. 
 

Level 0 
 No log is output. 
Level 1 (default) 
 Information about TCP/IP start/stop events and all errors that occurred is output. 
Level 2 
 In addition to the information output at level 1, information about all events related to TCP/IP 

is output. 
Level 3 
 In addition to the information output at level 2, all communicated data is output. 
 

Communication log data is saved as a file named NsSrnEth.log in the Fwlib folder within the Windows 
directory (For Windows Vista/7, "\FANUC\Fwlib" within the application folder for all users 
(Ex.:C:\Programdata)). 
 

Displaying the communication log 
The current communication log can be viewed using the "FWLOG.EXE" utility. The FWLOG.EXE 
utility is included in the following software. 

 
• System CD-ROM (version 2.0 or later) 
 FOCAS1/2 Library disk（A02B-0207-K737） 
 
• System floppy disks (version 1.9 or earlier) 
 FOCAS1/Ethernet Libraries（A02B-0207-K732#ZZ07） 
 
Start FWLOG.EXE directly from the CD-ROM or floppy disk. Alternatively, copy this file to any folder 
on the hard disk and start it. When the FWLOG.EXE utility starts, the Open dialog box appears. Use the 
arrow keys to select NCSRNETH.LOG and click the [OK] button. The log data screen appears. 
 
The following explains how to work with the log display screen. 
 
• Moving the cursor 
 Press any of the arrow keys on the keyboard. 
 You can page up or down by using any of the following methods. 
 ⋅ Choose [View] on the menu bar and then [Previous Page] or [Next Page]. 
 ⋅ Press the [Page Up] or [Page Down] key on the keyboard. 
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B ETHERNET VERSION 
COMMUNICATION LOG 

FUNCTION

• Copying to the clipboard 
 You can copy strings in the display area to the clipboard by using the following method. 

1. While holding down the [Shift] key on the keyboard, press any of the arrow keys to highlight 
the log record you want to copy. 

2. Choose [Edit] on the menu bar and then [Copy], or press the [Ctrl]+[C] keys on the keyboard. 
• Jumping to a specified line 
 Display the Jump dialog box by using any of the following methods. 
 ⋅ Choose [Edit] on the menu bar and then [Jump]. 
 ⋅ Press the [Ctrl]+[J] keys on the keyboard. 
 Enter the number of a record you want to display, and then click the [OK] button. 
• Making a search 
 Display the Find dialog box by using any of the following methods. 
 ⋅ Choose [Edit] on the menu bar and then [Find]. 
 ⋅ Press the [Ctrl]+[F] keys on the keyboard. 
 Enter a keyword you want to find, and then click the [OK] button. 
• Printing 
 Display the Print dialog box by using any of the following methods. 
 ⋅ Choose [File] on the menu bar and then [Print]. 
 ⋅ Press the [Ctrl]+[P] keys on the keyboard. 
 Select a range to print, and then click the [OK] button. 

Range Description 
All Prints the entire log file. 
This Page Prints only a page currently displayed on the screen. 

• Clearing a log 
 Choose [View] on the menu bar and then [Clear] to display the log clear dialog. 
 Click the [OK] button. 
• Monitor mode 
 In monitor mode, a log file is read at a specified interval (2 seconds by default) and the screen is 

refreshed. Monitor mode is off by default. 
 When monitor mode is on, the following functions are disabled. 
 ⋅ Print 
 ⋅ Copy 
 ⋅ Search 
 ⋅ Jump 
 ⋅ Previous page/next page 
 ⋅ Log clear 
 Monitor mode is switched between on and off by choosing [View] on the menu bar and then 

[Monitor]. 
• Page setting 
 You can change the number of log records per page and the refresh interval for monitor mode by 

using the following method. 
 1. Chose [View] on the menu bar and then [Page Setting…] to display the Page dialog box. 
 2. Change the number of log records and the refresh interval for monitor mode. 
 3. Click the [OK] button. 
 

Controlling logging 
You can check the current log level by using the LOGLEVEL.EXE utility. (Start LOGLEVEL.EXE 
directly from the CD-ROM or floppy disk. Alternatively, copy this file to any folder on the hard disk and 
start it.) 
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B ETHERNET VERSION 
COMMUNICATION LOG 
FUNCTION 

(Example) 
C:\>LOGLEVEL 
Current log level = 1 (Standard) 
 
C:\> 

 
You can change the log level by specifying a level with an argument of the LOGLEVEL.EXE utility. To 
cause the new log level to take effect, you must restart the CNC screen display function. 
 
(Example) 

C:\>LOGLEVEL 3 
New log level = 3 (Full) 
 
C:\> 
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C BITMAP SERVER FUNCTION 
This chapter explains the bitmap server function. 
 
Appendix C, “BITMAP SERVER FUNCTION”, consists of the following sections: 
 

C.1 ABOUT THE BITMAP SERVER FUNCTION 63 
C.2 START  64 
C.3 SYSTEM TRAY 65 
C.4 CNC SCREEN CONTROL LIBRARY 65 

 

C.1 ABOUT THE BITMAP SERVER FUNCTION 
This section describes overview of the bitmap server function. 
 
The bitmap server function in the CNC screen display function allows displaying a part or all of CNC 
screen (included C-language executor, Macro executor, PMC C language screen) in the user application. 
The bitmap server function provides two functions: one is a function to control the keyboard, mouse and 
the touch panel and the other is a function to display some CNC screen in one user application at the same 
time. 
 

NOTE 
1 The bitmap screen function is available on the CNC screen display function 

(HSSB connection and Ethernet connection) for the personal computer with 
Windows XP. 

2 The bitmap screen function supports Series 30i/31i/32i/35i, Series 0i-D/F and 
Power Motion i-A. Other CNCs do not support it. 

3 The original CNC screen display function cannot be executed while executing the 
bitmap server function. Execute the original CNC screen display function after 
terminating the bitmap server function. 

 

A part of CNC 
screen 

An example to display a part of CNC screen in the user application.

CNC screen image
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C.2 START 
This section describes how to start the bitmap server function. 
 
To use the bitmap server function, specify the following argument at the starting of the CNC screen 
display function. 
The argument is not case-sensitive. 
 
For HSSB connection: 

CNCSCRN  /SERVER 
 
The /NODE argument can be specified at the same time. 

 
For Ethernet connection: 

CNCSCRNE  /SERVER 
 
The /H and /T arguments can be specified at the same time. 
  

NOTE 
1 The bitmap server function of the following numbers can be executed at the 

same time. 
- For HSSB connection : 8 CNCs (Node0-7) 
- For Ethernet connection : 8 CNCs 

2 Refer to the “2.1 START AND TERMINATION (HSSB VERSION)” and “2.2 
START AND TERMINATION (ETHERNET VERSION)” as for the “/NODE”, “/H” 
and “/T“ arguments. 

 
After you start the CNC screen display function by specifying the above-mentioned argument, the CNC 
screen display function resides in the system tray without displaying the screen. 
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C.3 SYSTEM TRAY 
This section describes the function of the system tray of the bitmap server function. 
 
The following pop-up menu will be displayed by the right-click of the icon in the system tray. 
 

 
 

Menu item Brief description 
Data input/output… Settings of the data input/output folder for various data of the CNC. 
Setting… Settings of various items of the CNC screen display function. The "Switching between 

locations to save the settings" and the "Setting screen resolutions" are effective only. 
Keyboard Settings of the keyboard assignment. This item becomes effective after the update of the 

CNC screen is started. 
About… Display of the version information of the CNC screen display function. 
Exit Termination of the CNC screen display function. 

 
The functions of each menu item are the same as the original CNC screen display function. Refer to the 
“2. OPERATION” and “3. SETTING” as for details. 
 

C.4 CNC SCREEN CONTROL LIBRARY 
This section describes how to use the CNC screen control library of the bitmap server function. 
 
To use the bitmap server function in the user application, the following CNC screen control library (32/64 
bit version) is provided. 

• cncscrn_ctrl.dll (CNC screen control library) 
• cncscrn_ctrl.lib (Import library) 
• cncscrn_ctrl.h  (Header file) 

 
The CNC screen control library is stored in the "cncscrn_ctrl\win32" (32bit version) and 
"cncscrn_ctrl\x64" (64bit version) folder of the CD-ROM (A02B-0207-K775 (HSSB version) and 
A02B-0207-K776 (Ethernet version)), or "CNC Screen Display Function\HSSB" and "CNC Screen 
Display Function\Ethernet " contained in the DVD-ROM (A08B-9010-J555). 
 

Function list of the CNC screen control library 
No. Function Name Brief description 
1 sdf_start_hssb Starts the update of the CNC screen (For HSSB connection) 
2 sdf_start_ether Starts the update of the CNC screen (For Ethernet connection) 
3 sdf_stop Ends the update of the CNC screen 
4 sdf_register Registers the screen update message 
5 sdf_keyinput Notifies the key code 
6 sdf_mousepos Notifies the mouse position 
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C.4.1 Specifications of CNC screen control library 
(1) Starts the update of the CNC screen (For HSSB connection) 

 
Declaration 
 short sdf_start_hssb( long node_num, unsigned short *Hndl, DIB **pdib ); 
 
Description 
 The update of the CNC screen is started. It takes the several seconds to execute this function. 
 
Arguments 

node_num [ in ] 
 Specify the node number. (0,..,7) 
Hndl [ out ] 
 Specify the pointer to the variable in which the CNC screen control handle is stored. 
*pdib [ out ] 
 Specify the pointer in which the start address of the bitmap data (DIB data) of the CNC 

screen is stored. This data format is the DIB (Device Independent Bitmap).  
 
 The CNC screen can be displayed to the optional position in the user application Window 

by using this DIB data and the SetDIBitsToDevice() function of Windows API.
 Moreover, the BITMAPFILEHEADER is added to the DIB data and then the bitmap 
file can be made. Refer to the Web site of the Microsoft or the MSDN etc. as for the DIB 
data. 

 
 Example 

 An example to display a part of CNC screen to the graphic device contest (dc) in the user 
application Window: 
 

→ +X( 0, 0 ) 

↓ 
+
Y 
 

YSrc 

XSrc

dwWidth 

dwHeight

( 0, 0 )

（ XDest, YDest ） 

→ +X

↓
+
Y 
 

Application Window 
CNC screen

 
 

 long  node_num = 0; 
 unsigned short  Hndl; 
 DIB  *pdib; 
  
 ret = sdf_start_hssb( node_num, &Hndl, &pdib ); 

ret = SetDIBitsToDevice( (HDC)dc, XSrc, YSrc, dwWidth, dwHeight, XDest,  
    -pdib->bmi.biHeight – (dwHeight + YDest), 
    0, -pdib->bmi.biHeight, (CONST VOID *)pdib->image, 
    (LPBITMAPINFO)&pdib->bmi, DIB_RGB_COLORS ); 
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Return 
Return code Meaning/Error handling 

0 No error. 
1 The bitmap server function is not started.  
2 The update of the CNC screen has been already started. 
4 The node number is wrong. 
8 The bitmap server function cannot be executed. 

(Because the CNC screen display function is already executed, etc.) 
9 The creating of the DIB data failed. 

 
 
(2) Starts the update of the CNC screen (For Ethernet connection) 

 
Declaration 
 short sdf_start_ether( const char *ipaddr, unsigned short port, unsigned short *Hndl, DIB 

**pdib ); 
 
Description 
 The update of the CNC screen is started. It takes the several seconds to execute this function. 
 
Arguments 

ipaddr [ in ] 
 Specify the character string that presents a CNC's IP address or a host name to be 

connected. (Ex. "192.168.0.1" or "CNC-1.FACTORY")  
port [ in ] 
 Specify the port number of the FOCAS2/Ethernet (TCP) function.  
Hndl [ out ] 
 Specify the pointer to the variable in which the CNC screen control handle is stored. 
*pdib [ out ] 
 Specify the pointer in which the start address of the bitmap data (DIB data) of the CNC 

screen is stored. Refer to the sdf_start_hssb() for details. 
  

Return 
Return code Meaning/Error handling 

0 No error. 
1 The bitmap server function is not started.  
2 The update of the CNC screen has been already started. 
5 The IP address or the host name is wrong. 
7 The number of connected Ethernet exceeded the limitation. (Up to 8 CNCs) 
8 The bitmap server function cannot be executed. 

(Because the CNC screen display function is already executed, etc.) 
9 The creating of the DIB data failed. 
10 Socket error. Check your network connection (Ethernet cable etc.) 

 
 
(3) Ends the update of the CNC screen 

 
Declaration 
 short sdf_stop( unsigned short Hndl ); 
 
Description 
 The update of the CNC screen is terminated. 
 



C.BITMAP SERVER FUNCTION APPENDIX B-63164EN/11 

- 68 - 

Arguments 
Hndl [ in ] 
 Specify the CNC screen control handle. 
 

Return 
Return code Meaning/Error handling 

0 No error. 
3 The update of the CNC screen is not started. 

Start the update of the CNC screen by sdf_start_hssb() or sdf_start_ether(). 
6 The CNC screen control handle is wrong. 

 
 
(4) Registers the screen update message 

 
Declaration 
 short sdf_register( unsigned short Hndl, HWND hWnd, UINT nUpdateMsg ); 
 
Description 
 The Window handle of user application and the Window message number to receive the screen 

update message are registered. 
 
Arguments 

Hndl [ in ] 
 Specify the CNC screen control handle. 
hWnd [ in ] 
 Specify the Windows handle that receives the screen update message. 
 When you specify the NULL, the receiving of the Window message will be stopped. 
nUpdateMsg [ in ] 
 Specify the Window message number that is notified every time the CNC screen display 

function updates the screen. 
 

Explanation 
 When the Window handle and Window message number are registered by this function, the 

specified Window message will be sent to the user application every time the screen of CNC is 
updated. 

 The update area is notified by WPARAM and LPARAM of the Window message. 
 By updating the notified area of the screen only, the processing time can be saved. 
 
  x = LOWORD(wparam); X coordinate value of the update area 
  y = HIWORD(wparam); Y coordinate value of the update area 
  w = LOWORD(lparam); Width of the update area 
  h = HIWORD(lparam); Height of the update area 
   
Return 

Return code Meaning/Error handling 
0 No error. 
3 The update of the CNC screen is not started. 

Start the update of the CNC screen by sdf_start_hssb() or sdf_start_ether(). 
6 The CNC screen control handle is wrong. 
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(5) Notifies the key code 
 
Declaration 
 short sdf_keyinput( unsigned short Hndl, WORD flag, WORD code ); 
 
Description 
 The key code is notified to the CNC. 
 
Arguments 

Hndl [ in ] 
 Specify the CNC screen control handle. 
flag [ in ] 
 Specify "0" that means the key-up, and "1" that means the key-down. 
code [ in ] 
 Specify the key code of the CNC. (It is valid when flag=1.) 
 
 The available key code is shown as follows: 

 0 1 2 3 4 5 6 7 
0   SP 0 @ P ` p 
1   ! 1 A Q a q 
2   " 2 B R b r 
3   # 3 C S c s 
4   $ 4 D T d t 
5   % 5 E U e u 
6   & 6 F V f v 
7   ' 7 G W g w 
8   ( 8 H X h x 
9 TAB  ) 9 I Y i y 
A EOB  * : J Z j z 
B   + ; K [ k  
C   , < L \ l  
D   - = M ] m  
E   . > N ^ n ~ 
F   / ? O _ o  

 
 8 9 A B C D E F 

0  RESET [SVF9]     [SHF1] 
1   [SVF8]     [SHF2] 
2   [SVF7]     [SHF3] 
3   [SVF6]     [SHF4] 
4 SHIFT INSERT [SVF5]    AUX [SHF5] 
5  DELETE [SVF4]     [SHF6] 
6 CAN ALTER [SVF3]     [SHF7] 
7  ALT [SVF2]     [SHF8] 
8 → INPUT [SVF1]    POS [SHF9] 
9 ← CALC     PROG [SHF10] 
A ↓ HELP     OFFSET/ 

SETTING 
 

B ↑ CTRL     SYSTEM  
C  ABC/abc     MESSAGE  
D       GRAPH  
E Page↓      CUSTOM [FR] 
F Page↑      CUSTOM2 [FL] 
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Return 
Return code Meaning/Error handling 

0 No error. 
3 The update of the CNC screen is not started. 

Start the update of the CNC screen by sdf_start_hssb() or sdf_start_ether(). 
6 The CNC screen control handle is wrong. 

 
 
(6) Notifies the mouse position 

 
Declaration 
 short sdf_mousepos( unsigned short Hndl, WORD flag, short px, short py ); 
 
Description 
 The mouse position is notified to the CNC. 
 
Arguments 

Hndl [ in ] 
 Specify the CNC screen control handle. 
flag [ in ] 
 Specify "0" that means the mouse-up, and "1" that means the mouse-down. 
px [ in ] 
 Specify the X coordinate value (pixel unit) of the mouse position. 
py [ in ] 
 Specify the Y coordinate value (pixel unit) of the mouse position. 

 
Explanation 
 The mouse position specifies the value based on the upper-left of the CNC screen instead of the 

position in the user application Window. 
 

( 0, 0 ) → +X 

↓
+
Y 
 

CNC screen 

( xpixel - 1, ypixel – 1 ) 
 

 
Return 

Return code Meaning/Error handling 
0 No error. 
3 The update of the CNC screen is not started. 

Start the update of the CNC screen by sdf_start_hssb() or sdf_start_ether(). 
6 The CNC screen control handle is wrong. 
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